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1. Introduction

Use the Control4® Composer Home Edition (Composer HE) Monitoring, Media, Agents and
Programming views to modify your system. Refer to the Composer HE Getting Started help in the
Composer HE application for basic startup information (located in the menu bar, or in PDF format on
the Control4 web site).

This document gives you more comprehensive information, tips, best practices, and examples about
how to use Composer HE for the Control4 Operating System (OS) Release 2.0 (OS 2.0).

1.1 Purpose

The purpose of this document is to give you instructions and examples about how to use the
Composer HE application to monitor your system, set up your media, program the system, use
agents, and it also describes other useful Composer HE tasks.

See Control4 Composer HE Getting Started for installation, setup, and other getting started
instructions such as how to become familiar with the Composer HE interface.

1.2 Related Documents and Resources

Document file name Title and location

Composer HE Getting Application Help: Composer HE Help menu
Started (200-00169) PDF: http://www.control4.com/products/documentation/

Control4 System Quick | PDF: http://www.control4.com/products/documentation/
Start Guide (200-00153)

Control4 System User | Web Help:
Guide (200-00001) http://www.control4.com/uploads/help/System UG/Control4 System User
Guide.htm

PDF: http://www.control4.com/products/documentation/

Control4 System PDF only: http://www.control4.com/products/documentation/
Remote Control SR-
250 User Guide (200-

00152)
Composer ME User Application Help: Composer ME Help menu
Guide (200-00171) PDF: http://www.control4.com/products/documentation/

2. Monitoring the System

Note: This section assumes you are familiar with the Composer HE interface. If you are not, see
Composer HE Getting Started.

The Control4® Composer HE Monitoring view is designed to help you view your system, rooms, and
devices. To access the Monitoring view, start Composer HE. When you choose the Monitoring view
(highlighted in the lower left pane), you have two (2) tabs to choose from: List View and Properties.

Copyright © 2010 Control4. All Rights Reserved.
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Check the Device Status in List View

The default page in the Monitoring view is ‘List View' (first tab, top-right) which lets you view all the
devices in your Control4 system and their current state.

List View groups devices under the rooms to which they're assigned. In the example above, all of the
devices are located in the Living Room because the Living Room is selected in the project tree
(Monitoring pane).

e Monitor Status

You can monitor the status of devices in the system. In List View, double-click on the
device's icon to bring up the device's controls. Light levels are indicated with slider bars and
buttons for on or off state. Each device has a different set of controls.

e Device Controls

You can access the device's controls by double-clicking on any device icon in either the
project tree or the List View tab.
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Try this:

Double-click on any device with an On/Off option to access the device's controls, for
example, a Switch. Turn the device on or off; some devices have a color change on the
icon in the Device Control and in the List View.

See also “Checking the Device Status.”

Change Project Properties
The main Composer HE view shows the Properties pane. Click the Properties tab to expose it.
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The Properties pane contains the following elements:

e Project Properties. Lets you change general information about the project according to the
location of the Control4 system. In the project tree, click the project name (Bev's Office is the

example above).

Use the Project Properties pane to do the following:

e Change the name of the project.

e Change/enter the zip code of the location where the Control4 system resides.
e Change the date and time.

e Change the project settings.

o Enable SSL and password for security purposes.

Copyright © 2010 Control4. All Rights Reserved.
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e Change localization options.
e Room Properties. In the project tree, click a room to view its Properties.

This lets you edit Room Properties in the following tabs:

e Audio Video Devices. Shows your available audio and video devices, where your audio
and video end points are, and what is controlling the volume. If a device does not appear
in this window and you think it should, check the connections. The connections probably
are not mapped properly.

e Navigator. Lets you hide/re-order the device's visibility and display order in a room,
including Lighting Scenes.

e Miscellaneous. Lets you enable the default audio or video volume for a room, and assign
an IP mask to the room for programming a third-party remote.

o Device Properties. Click on a device from the project tree to see its editable properties. For
example, you can set the one-click ramp up and ramp down rates on a Wireless Dimmer.
You can also edit the LED colors for all of your Switches, Keypads, and Dimmers.

Control4 recommends that you look over the properties of each device to see how you can change
them.

See also “Checking the Device Status” (next) or “Changing Project Properties” later in this document.

2.1 Checking the Device Status

Use the Control4® Composer HE Monitoring view to check the status of the devices in your system by
room.

Copyright © 2010 Control4. All Rights Reserved.
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2.1.1 Prerequisites

Ensure that the devices you want in your system have been added and identified to the system.
Check with your Control4 Dealer or Installer to add devices.

2.1.2 Procedure

To check device status:

1.
2.

3.
4.
5.

Start Composer HE and connect to a Director.

In the project tree, select a room. The devices are categorized by the room in which the device is
installed.

Click the List View tab.
Double-click a device to bring up its configuration and controls.
Check or change the configuration as needed.

2.2 Changing Project Properties

Use the Control4® Composer HE Monitoring view to check and change the properties of your project.
You can change device and room properties also, but they aren't discussed in this section.

2.2.1 Procedure

To change the Properties:

1. Start Composer HE and connect to a Director.
2. Click the Properties tab.
3. Change the boxes as needed:

¢ Name: Enter the project name.

e Location: Click Lookup to change the Latitude and Longitude based on the location of the
system by entering the city, state, or zip code.

¢ Date & Time: Use the drop-down lists to select the date and time. Click edit to change the
timezone.

e Project Settings Control: Check Push Settings From Project to set a device in Composer
HE not to allow the setting to be overridden at the device.

e System Security: If set, all Navigators must connect through a secure connection. Secure
Connections Only (SSL)—Check this box if you want all Navigators in this system to go
through a secure connection. Click Change Password to change this password.

e Localization: Lets you set the locale and character set for countries outside the Unites
States.

e Locale—Use the down arrow to change the locale.
e Encoding—Use the down arrow to select the character set.
e Add Locale—Click to locate the PO files to convert and the Locale Code. Click OK.
Copyright © 2010 Control4. All Rights Reserved.
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Setting Up Your Media and Playlists

To take full advantage of media lookup services by Gracenote®, you must be registered in 4Sight. See
Composer HE Getting Started for details.

After you have completed the initial setup of Control4® Composer HE (see Composer HE Getting
Started), you can set up and modify the media in your system.

Note: The AMG lookup service used in previous releases has been changed to Gracenote®. The Sony
777 Disc Changer uses Gracenote for its lookup, but the Media Controller can no longer access
album, title, or artist information from AMG. CDs, however, can be imported and will show up in the
Media database with a date and time stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and Media Monkey to create MP3s. You can still use Composer ME and Composer HE to add
files to Control4.

To view and select the media from the Navigators—the On-Screen, Touch Screens, System Remote
Control (to select media on-screen), and LCD Keypad—you first need to add and scan the media into
the Media Database which resides in Director on the Primary Controller. Use the Media view to
perform these activities.

Media view:

o
% Disc Changes
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Video Media
i CHM Flach Dk & mma 3
D Semen Saver
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If you have MP3, FLAC, or AAC files stored in your system, you can create playlists. To add and scan
songs and albums for playlists, they must be available in MP3, AAC, or FLAC format on a PC,
Controller, or network share.
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Tip: Composer HE requires that your Control4 Installer adds your system hardware successfully to
your project before the media stored on that hardware can be added and scanned. For example, if a
Disc Changer does not appear in the project tree, the media stored in the Disc Changer cannot be
added or scanned. Contact your Control4 Dealer or Installer to add a device that does not appear in
the system.

Setting Up Media Stored on a Controller

When you set up media on a Control4® Controller with storage space for media, the Controller has a
built-in Digital Audio Player. A Home Controller HC-1000 V3 has disk space.

Digital Audio is the component in the Controller that provides digital audio streaming. Each source
device that can provide an audio stream, whether itis a CD changer plugged into the analog inputs on
a Speaker Point or a Controller, can provide audio to the digital audio servers.

Use the Composer HE Media view to set up your media to view and play.

Prerequisites

Ensure that the media devices have been added and identified to the Control4 system. Your Installer
can help you do that.

Procedure
To add and scan available Digital Audio Player media:
1. In Composer, click the Media view.

2. Inthe Media view's project tree, highlight the Controller or attached USB storage with the media
that you want to add to the Media pane.

3. Inthe Controller pane (right pane) or Network file storage, click Add.

- 5 — R 1

- - =

4. Browse to the directory of music files to add. Only MP3, M4A/FLAC, or AAC formatted files can

be added.

When the files are added, the scan automatically starts. After a few moments the media is
scanned, and you will see a list of albums appear. You may see the On-screen Navigator update
during this process also.

Copyright © 2010 Control4. All Rights Reserved.
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Tip: Another way to add files from a network share to a Controller is to go to the Windows Start
menu, and select Run. Type //<Controller's IP
Address>/media/audio/music/<Artists>/<Albums> and copy the files there.

5. Refresh the Navigators. The media is now selectable for viewing in the Navigators.

Note: If no cover art is found in the file’s metadata, then no cover art is associated with the music
unless the system is registered in 4Sight, and you can go to the online media lookup (Media view
> Edit > Name > Search > Select > Next) to obtain the cover art for your music. Check with your
Control4 Dealer or Installer for details.

Setting Up Media on a Disc Changer

When setting up a Control4® Disc Changer to play music or movies, you can add and scan media in
Composer HE according to the options available on your Disc Changer. Adding and scanning
populates the media information to the Media Database, which lets you view the media from your
Navigators.

Note: The AMG media lookup service has been changed to Gracenote®. The Sony 777 Disc Changer
uses Gracenote, but the Media Controller can no longer access album, title, or artist information from
AMG. CDs, however, can be imported and will show up in the Media database with a date and time
stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and Media Monkey to create MP3s. You can still use Composer ME and Composer HE to add
files to Control4.

In the Media pane, when you highlight Disc Changer, if the options are available on your Disc
Changer, you will see following active buttons:

Copyright © 2010 Control4. All Rights Reserved.
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e Scan—Lets you add and scan media located on your Disc Changer, and add it to the Media
Database (recommended if available).

e Search—Lets you search for media titles located on your Disc Changer, and add them to the
Media Database.

e New DVD or New CD—Lets you add new DVDs and CDs to the Media Database.
o Edit—Lets you edit by Type, Title, Artist, Genre, etc.
e Delete—Lets you delete an entry.

The following sections demonstrate how to add a Disc Changer to the Media Database with these

options.
3.2.1 Prerequisites
Ensure that the Disc Changer has been added to the project and identified. Check with your Control4
Dealer or Installer to do this for you.
3.2.2 Procedures
To scan media on the Disc Changer to the Media Database:
1. Inthe Media view, select Disc Changer in the Media pane.
2. Inthe Disc Changer pane, click Scan. The scan results appear.
3. Refresh the Navigators. You are ready to play music now.
To search media on the Disc Changer and add it to the Media Database:
1. Select the Controller in the Media pane.
2. Inthe Disc Changer pane, click Search. The search dialog appears.
3. Type the DVD name in the blank box, for example, type ‘A Beautiful Mind’ and click Search. The
possible DVD title matches from the Web database appear in the Search Results window.
4. Use the scrollbar if necessary to find the appropriate DVD title.
5. Highlight the appropriate DVD title, drag it directly over the empty line item, and select it.
Copyright © 2010 Control4. All Rights Reserved.
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Highlight the cover art and drag and drop it directly
over to highlight the empty line item in the DVD pane.
If you are adding DVDs for a multiple IR-controlled
DISC Changer, you would add it in the same manner.

6. Click Finished.

7. Repeat these steps for the DVDs/CDs in the Disc Changer that you want to add to the Media
Database.

8. Refresh your Navigators. The media you added is now selectable for viewing in the Navigators.

To add and search using the New DVD or New CD options:

1. Inthe Media view, select Disc Changer in the Media pane.

2. Click in the empty box for the New DVD and New CD buttons to appear.
3. Click either New DVD or New CD as appropriate.

DISC Changer

# VOR
s DISC Chargpes

The New Movie or New Album dialog appears.

4. In the Title box, enter the DVD you want to play, for example, 'A Beautiful Mind.'
Copyright © 2010 Control4. All Rights Reserved.
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5. Click Search.
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[ Remove Al ]
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6. When the Search dialog appears, use the scrollbar if necessary to find the appropriate cover art,
and then select it.

7. (Optional) You can change the search criteria and search again if necessary. The possible
matches from the Web database appear in the Search Results window.

8. Click Next. You can choose which information to import, and then edit any associated information
before adding it to the Media Database.

9. Click Finished.
10. Click OK.

Copyright © 2010 Control4. All Rights Reserved.
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11. Refresh your Navigators. This particular DVD is now selectable for viewing in the Navigators.

Note: Use these steps for new CDs also. Similar results occur.

Setting Up Videos for a Media Player

Your Control4 Dealer or Installer can help you get set up to play videos on your Media Player.

For information about scanning files for the Media Player, see the Media Player Installation and Setup
Guide or the Media Player User Guide.

Auto-Scan Mediain Composer HE
This section applies to a Sony CX777ES Disc Changer.

The benefits of running a Control4® Disc Changer with bi-directional communications (RS-232), for
example, Sony CX777ES, is that you can scan your DVDs or CDs stored in the Disc Changer to
identify, index, and automatically apply cover art and media information. You can have your Control4
Dealer or Installer configure your Control4 system in Composer HE to scan media automatically, or
you can set a manual scan using the Scan button. The default is to scan media manually.

Notes:

1. If youscan a DVD or CD, and the media is not recognized, it will be titled “unknown.” You can edit
the DVD or CD's metadata and manually provide this information from either Composer HE or the
Navigators. If this DVD or CD is then changed to a different slot, the system will apply this same
information.

Copyright © 2010 Control4. All Rights Reserved.
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2. Because media scanning has been moved to the background, the scanning status is only
available through Director status messages. To do this, you can either watch the Director status
line or re-select the media to view the content that has been scanned.

3. Composer HE does not need to be open to scan media. This lets you use other media managers
(iTunes, Windows Media Player, etc.).

3.4.1 Prerequisites

Ensure that the devices you want to scan have been added and identified in the Control4 system.
Your Control4 Dealer or Installer can do this for you.

If you want to schedule regular scans, ensure that your network-attached storage is set up and is
accessible from Composer HE.

3.4.2 Procedure

To schedule a regular scan of media from a network-attached device for a Media Player, for example:

1. From the Composer HE main screen, click the Media view, and then select Media Scanning
Options. To scan your media now (and not set up a scheduled scan), click Scan Now and skip
the Scanning Schedule in Step 2.

2. Inthe Options pane, set the schedule as follows:
e Scanning Schedule. Select one.
e Never. Select if you never want to schedule an automatic scan.
e Every x Days or Weeks (up to 10). Select the frequency to scan.
e Onthefollowing days. Select Sunday through Saturday.

e At <time>. Use the up and down arrows to select the time. Highlight AM or PM and type
the value: AM or PM.

e Files To Scan. Select a device and extension.
e Network File Storage. Select if you have a NAS you want to scan.

e USB Drive. The manufacturer's USB drive appears here. Select if you have a USB drive
you want to scan.

e Extensions. Use the up and down arrows to choose the file type to add or remove. To
add a file extension if it doesn't appear in the list use the down arrow to select the
extension, select Video or Audio, and then click Add. Click Remove to remove that file
type from the list.

e Use Online Media Lookup to improve scan results. Check if you don't want the search
to access the Internet for every format lookup, for example, a specific title or cover art.
Tip: Properly tagged files will result in must faster access.

e Remove media from the database if the files no longer exist. Check to remove
database information when a media file has been deleted. Be careful, however, because
if for example you disconnect a USB drive with media on it, the database files will delete
them if checked, and you may not want to delete them if you use the drive again.

e Update media database if file tags have changed. Check to have the database
updated if the metadata changes.

3. Click Apply.
4. Click Scan Now to start the scan immediately or Stop Scan if you've started the scan and want to
stop it.

3.5 Setting Up Media for Television Channels

Copyright © 2010 Control4. All Rights Reserved.
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Use the Control4® Composer HE Media view to set up your local broadcast channel stations and
listings for display in the Navigators.

3.5.1 Prerequisites

Ensure that the broadcast media has been added and identified to the Control4 system. Check with
your Control4 Dealer or Installer who can do this for you.

3.5.2 Procedure
To set up media for Broadcast Television Channels:
1. Inthe Media view, click UHF/VHF or other broadcast media type.
2. Click Search.
3. When the dialog appears, type your zip code in the box.
4

Click Search and use the pull-down menu to select the Local Broadcast Listings. The available
channels are populated to the Search Results.

Note: This feature is only available in the United States.

5. Click the boxes to select the desired channels that you want to appear on the Navigators.

6. Click OK.
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The selected stations populate in the UHF/VHF pane. You can edit the information as needed;
add a description, genre, etc.
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7. (Optional) To edit a channel, select the channel, and click Edit. The following dialog appears.
8. Edit the information and click OK.
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9. Refresh your Navigators. You can now view and select the media from the Navigators.
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3.6 Setting Up Media for Radio Stations

Use the Control4® Composer HE Media view to set up your media for radio broadcast stations.

3.6.1 Prerequisites

Ensure that the broadcast media has been added and identified to the Control4 system. Check with
your Control4 Dealer or Installer who can do this for you.

3.6.2 Procedure

To set up media for broadcast radio stations:

1. Inthe Media view, click AM Radio, FM Radio or XM Radio.
2. Click Search.
3. When the dialog appears, type your zip code in the box.
4. Click Search again. Use the pull-down menu to select AM Broadcast Stations or FM Broadcast
Stations. The available stations are populated to the Search Results window.
5. Click the boxes to select desired stations that you want to appear on the Navigators.
6. Click OK.
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The selected stations populate in the AM or FM Radio pane.
7. (Optional) To edit a station, select the station, and then click Edit.
8. Edit the information, and then click OK.
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9. Refresh your Navigators.

10. Repeat the previous steps for each radio (AM, FM, XM) you want to set up. Set up each one
separately. The media is now ready to view and select from the Navigators.

Setting Up Media Auto-Scan

Your Control4® Dealer or Installer can use the auto-scan feature in Composer Pro to scan your media
automatically. Auto-scan applies to Disc Changers, Media Players, network-attached storage, and
USB disks.

Media Player

Note: The Media Player uses the Network File Storage option in the Media view. Any time new
content is added, the files must be scanned again.

For information about scanning files for the Media Player, see the Media Player Installation and Setup
Guide or the Media Player User Guide.

Disc Changer

This section applies to a Sony CX777ES Disc Changer. The benefits of running a Disc Changer with
bidirectional communications (RS-232), such as the Sony CX777ES, is that your Installer can scan
your DVDs/CDs stored in the Disc Changer to identify and index media, and automatically apply cover
art and information. Ask your Dealer or Installer to do this for you.

Testing the Media Information

To test control of media through the Control4® Navigators (System Remote Control, On-Screen
Navigator on the TV, LCD Navigator, or any of the other Navigators or Touch Screens), use the steps
outlined in the Control4 System User Guide.

Copyright © 2010 Control4. All Rights Reserved.
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Suggested test items:
e Playing an album
e Adding an album or track to the Now Playing queue
e Playing a playlist created in Composer
o Creating a playlist at a Navigator (for example, one of the Touch Screens)
e Playing multiple streams of music (play different music in different rooms)
e Playing a movie on the television

Using External Storage Devices

You can access digital music from an external storage device attached to your Control4® system.
External storage devices include USB flash drives or USB external hard drives or a PC'’s drive located
on the home network.

Set up your external storage device and networked file storage as described in this section using
Composer HE.

Note: If you disconnect and remove the external drive (network-attached storage, USB, etc.), the
music is no longer available. To access the music again, reattach and add the external storage
device, and the refresh the Navigators.

Prerequisites

Ensure that your external storage device has been added to the Composer project and identified.
Your Control4 Dealer or Installer can help you do that.

External storage devices must have media stored in unprotected MP3, FLAC, or MAA/AAC formats.

Procedure
To attach and scan external storage devices using a USB connection:
1. Power on the external storage device.

2. Use the documentation provided with your Control4 Controller to attach the external storage
device using the USB port.

3. When you connect the external storage device, scan the music residing on that device so that the
music is available to the Control4 system.

4. Click the Media view.
In the tree view, select the external storage device.
6. Click Scan. The media residing on the external storage device is available in the Control4 system.

o

Note: You can add media from the external storage device when connected to the Controller.
However, it is recommended that you connect your external drive directly to the PC where you want to
copy the media.

When scanning, the media appears when it is located on the Controller.

Copyright © 2010 Control4. All Rights Reserved.
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To access and scan network storage devices:
1. Select the Network File Storage object.

Note: This type of setup must be performed by your Control4 Dealer or Installer using Composer

Pro.

2. Click Add or Scan.

Creating a Playlist

Use the Control4® Composer HE Media view to set up a playlist to play songs and albums from your

Touch Screens, On-Screen Navigators, or System Remote Control.

Note: To set up a playlist in Rhapsody, check with your Contol4 Dealer or Installer or see the Control4

Quick Start Guide or Control4 System User Guide.

3.10.1 Prerequisites

Ensure that you have scanned your media from your media storage device to the Digital Audio player
on the Controller.

3.10.2 Procedure

Saved: 6/30/2010 8:46:00 AM

To create a playlist:
1. From the Media menu, select New Playlist.
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‘New playlist' appears that you can rename immediately, or later you can right-click and select
Edit to change the name.

Example: Change New to Frank’s Playlist.

The playlists are designed exclusively for streaming media in Digital Audio. Playlists are not
intended to include broadcast channels or stations.

3. Select the Controller.

4. Drag and drop any albums or songs you want to add to the playlist.
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5. (Optional) To delete unwanted songs after you've added the albums, highlight the playlist by right-

clicking the song and selecting Delete.

Tip: To remove individual songs, right-click Delete. To remove multiple songs, press Shift,
highlight the items to remove, and then right-click Delete.

Copyright © 2010 Control4. All Rights Reserved.
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6. Edit and play your playlists using the Navigators.

Tip: You can create new playlists from your Touch Screens or On-Screen Navigator also. See
the Control4 System User Guide for details.

3.11 Editing Media Information

Use the Control4® Composer HE Media view to edit your media information for 'unknown' DVDs or
CDs. You can edit media information also in the Navigators.

3.11.1 Prerequisites

Ensure that the appropriate media devices and media have been added and identified to the Control4
system. Your Control4 Dealer or Installer can help you do this.

3.11.2 Procedure

To edit CD information:

1. Inthe Media view, double-click the device for which you want to edit the media, such as CD, Disc
Changer, Media Player, Digital Audio, etc.

2. Click Edit or double-click the album in the Album Title column. The album's dialog box appears.

3. To edit and enter any changes, click the Album tab.

4. Click the boxes under Name, Artist, Label or Genre. In the Tracks and Notes tabs, view and edit
Track Titles and Notes.

5. Click Search next to Name or Artist to search the database for similar entries.

Copyright © 2010 Control4. All Rights Reserved.
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6. To add artwork, click Find Art File.
7. To remove the album cover art, click Remove Art.
8. When you are finished, click OK.
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9. To select a search result, select the album Title and click Next.

10. View and edit the information for the album, including Name, Artist/Composer, Label, Genre,
Year, Art, and Notes.
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11. Make changes as desired. Click Back to return to previous screens.
12. Click Finished.

Search ?

] Hame [ hat =] Hobex
4 + Fous [Hybwed S8LCTF]
EF.T T e——
Turtie | fared Sy Quarist
] Lkl
T el
=] Geres =] Yom
Mewsign M5

Camvend Track Musses snd Tils [#] Mem Tiaok M ussber and 1l

1 Ao o fraursd =
01 Brogrd Bl Brogrd el

# Condessin' T he Bl
03 Gontind B B g}

1 Emply Hoat

07 Frvgy Haat gl

A Time | O by Side

b Tom: i D By il g

5. Grosael Tt Bl T im
0 Camoel Tirnpa Kl T g 3

0 200G AN s Casck LG
AN Lot et Ly A Mckis el & Braciestuirk. o AN Mia Jaids, LLE < IEinch. 4IEEI|~

To edit DVD information:
1. Inthe Media view, select the movie under Disc Changer or DVD.
2. Click Edit or double-click the title under Discs.
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3. Click the Movie tab. Edit the Title, Director, Studio, Genre, Run Time, Release date and
Rating as desired.

4. Click the Cast and Synopsis tab. Click the Cast and Synopsis boxes, and make the desired
changes.
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5. Click Search in the Movie tab to search the database for other DVDs.
6. Double-click the desired DVD and edit as desired according to the previous steps.
7. When you are finished, click Finished.

Programming the System

Use the Control4® Composer HE Programming view to program your Control4 system.

Programming Basics

Use the Control4® Composer HE Programming view to configure events and actions. In Composer
HE, click Programming to display the Programming view.

Configuring is based on events. When an event starts, it triggers actions to take place.

Example: When the projector screen is lowered (the ‘event’ starts), the receiver, DVD player, and
projector all power on (the ‘actions’ of the receiver, DVD player, and project are all caused by the
screen-lowering event).

To program the Control4 system, you use Composer HE to drag-and-drop events and actions for
corresponding devices to a Script pane. Details about how to do this are explained below.

Copyright © 2010 Control4. All Rights Reserved.
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This table describes what events, actions and scripts are used when configuring the system, and how
they are used.

Item Description

Events All programming begins with events. An event is a “when” statement: the trigger reporting
that something happened, resulting in an automated action. Events happen instantaneously.

Example: On a Keypad, pushing a button is one event. Actions all happen under events.
Other events include:
When the door opens

When it is 7:00 a.m.
When it is sunrise

Actions After the event communicates to the system that something happened, it will send actions.
These methods are used to define actions:

Commands. The Commands tab displays all available commands for a selected item in the
Device Actions tree. A command is a “do” statement. Commands are actions the Director
tells the device to do so it performs a certain behavior.

Examples of commands include:
Light: on, off

VCR: play, stop, pause

CD Changer: go to disk

Security device: arm, disarm

TV: Power on/off, change channel

Conditionals. The Conditionals tab displays all available conditionals for a selected item in
the Device Actions tree. A conditional is an “if” statement. An “if” statement asks a true/false
question to the device.

Examples of conditionals include:

If door is open

If after 5 p.m.

If the light is greater than 50 percent

Delays. A Delay stalls a program from running to ensure that the actions happen at the right
time.

Script The linking of events and actions is defined in the script. These events and actions get
moved into the Script pane.

Tip: You can use Properties, Agents and Variables also to configure or program devices. These are
considered advanced configuration and programming. See “Programming with Agents” in this
document for information.

Basic programming consists of two (2) parts:

1. Define a device’s events that trigger the actions.
2. Define a device's actions to trigger when an event fires.

Copyright © 2010 Control4. All Rights Reserved.
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Refer to the steps in the next two (2) figures to learn about basic Control4 system programming tasks.

1. Define the device's events (follow the screen’s steps and arrows below):
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2. Define the device's actions (follow the screen’s steps and arrows below):
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Note: Programming makes use of agents also, which let you include pre-programmed system
functionality, such as scheduling, delays, or setting up Lighting Scenes.

Example: To program around sunrise and sunset, you use the Scheduler agent. See
“Programming with Agents” for information about using agents in programming.
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4.2 Programming with Commands
Use the Control4® Composer HE Programming view to configure Commands.
A Command is a “do” statement. Commands are actions that tell a specific device what to do.
Example: The steps below show how to configure a 3-Button Keypad to turn on the sprinklers using a
relay for control.
4.2.1 Prerequisites
In this example, ensure that the devices you want to configure (Controller, 3 Button Keypad and
Sprinklers Relay) are added and identified to the system. Your Control4 Dealer or Installer can help
you do this.
The following example requires these devices in your project:
e Controller
e 3 Button Keypad
e Sprinklers
4.2.2 Procedure
To Program a 3 Button Keypad to Toggle Sprinklers On and Off:
1. In Composer HE, click Programming.
2. From the project tree, click 3 Button Keypad.
3. Click the button that you want to program—Button 1 (selected by default).
This automatically identifies the 'Press' event for programming. The event appears at the top of
the Script pane (center pane).
e ok e
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4. From the Actions pane (right pane), highlight Sprinkler System.
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Click the Commands tab, and select Toggle the Sprinkler System. The command you chose
(Toggle the Sprinklers) displays in the right middle pane.

Click the green arrow, and drag it to the Script pane (center pane).
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7. Click Execute to turn on the sprinklers.
8. Click Execute again to turn off the sprinklers.
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9. Now press the top button on your 3-Button Keypad to toggle the Sprinklers on and off.
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4.3 Programming with Delay, Stop, and Break Commands
Use the Control4® Composer HE Programming view to program using Delay, Stop and Break
Commands.
Delay provides a delay command in response to an event that waits for a specified period of time
before executing the next command in a code item.
When configuring a device, you always have the following options:
e Delay—Lets you delay an action that is taking place.
e Stop—Lets you stop all programming.
e Break—Lets you break out of a conditional loop when a specified condition is met and return
to programming outside of the loop. Note: Usually, the Break command is available only in
Composer Pro, but it might be present in the programming set up for your project.
4.3.1 Prerequisites
Ensure that the devices you want to program are added and identified to the system. Your Control4
Dealer or Installer can help you do this.
4.3.2 Procedure
To use Delay, Stop, and Break commands during programming:
1. In Composer HE, click Programming.
2. Select a device and an event.
3. To use the Delay, Stop, or Break commands, from the right-side pane, select the Programming
Control object (scroll down to bottom of the project tree to find it).
4. Click the Commands tab, select Delay, and select the number of seconds (for example, 5
seconds). The delay appears in the left-side middle pane.
5. Drag and drop the delay command to the Script pane. Example: This will ensure that there is a 5-
second delay after the projector powers on.
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4.4 Programming with Conditionals
Use the Control4® Composer HE Programming view to program using conditionals.
A conditional is an “if” statement that asks a true or false question to the device.
Example: The steps below show how to use conditionals in programming. In this example, “when” a
doorbell is pressed and the light is off, program the light to turn on.
4.4.1 Prerequisites
In this example, ensure that the devices you want to program (Controller, Doorbell and Theater
Switch) are added and configured in the system. Your Control4 Dealer or Installer can help you do
this.
The following example uses these devices in the project:
e Controller
e Doorbell
e Theater Switch
4.4.2 Procedure
To program a conditional that turns on the light when the doorbell is pressed and the light is off:
1. In Composer HE, click Programming.
2. From the project tree, highlight Doorbell.
3. Select the When the Doorbell is pressed event.
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The event appears at the top of the Script pane (center pane).
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4. From the Actions pane (right pane), click West Light (switch).

5. Click the Conditionals tab, and select Is Off. The system displays the conditional you chose in
the right middle pane.

6. Click the blue question mark, and drag it to the Script pane.
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7. From the Actions pane, click West Light again.
8. Inthe Commands tab, select On. The command you chose displays in the right middle pane.

9. Drag the green arrow directly on top of the blue question mark in the Script pane to make it a
child under the When the Doorbell is pressed statement.
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Tip: If you drag the action to the text, or you drag the action under the text into the open space, it
places the action as an equal above the conditional. If you drag the action to the question mark, it
becomes a child under the conditional. Watch the arrow to see in which direction it points to place the
action as a peer or a child below the statement.
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10. Go to your Theater Switch, and ensure that the light is off.
11. Press your doorbell button, and the light turns on.

4.4.3 Using Room Variables
Control4® room variables provide greater flexibility in programming, letting you program using events
and actions at the room level.
Note: Most of the functions in Room Variables are available by selecting the Room object. Selecting
the Room object is the recommended method for configuring the room. Whenever possible, use the
Room object rather than Room Variables.
4.4.3.1 Procedure
To use room variables:
1. Start Composer HE and connect to a Director.
2. Click Programming. In this view listed under every room in the project tree is a Room Variables
object.
3. Click to expand the Room Variables options. Room variables are available as events and
actions.
Copyright © 2010 Control4. All Rights Reserved.
Saved: 6/30/2010 8:46:00 AM 200-00170_Composer HE Page 38 of 117

User Guide



Room Variables:

Programming

* Home

@ Houze

=5 Main

Eﬁ Bev's

=®

Composer HE User Guide

Room Wariables

B CURRENT_SELECTED_DEWICE
Y CURRENT_MEDIA

" POVWER_STATE

B CURRENT_VOLUME

" HAS_DISCRETE_VOLUME
B HAS_DISCRETE_MUTE
B I5_MUTED

& IN_NAVIGATION

B USE_DEFALLT_WOLUMES
B DEFAULT_AUDIO_WOLUME
B DEFAULT_IDED_OLUME
B VOLUME_IS_LINKED

& MUTE_IS_LINKED

B ROOMOFF_IS_LINKED

[

(&) When Project Bev's Dffice Loads

Saved: 6/30/2010 8:46:00 AM

Copyright © 2010 Control4. All Rights Reserved.

200-00170_Composer HE

User Guide

Page 39 of 117



Composer HE User Guide

The room variables are described in the following table.

Events/Actions Description

CURRENT_SELECTED_DEVICE | Lets you do programming when any device changes in the room.

CURRENT_MEDIA Lets you do programming when any media changes in the room.

Lets you do programming when any device’s power state changes from
POWER_STATE True to False in the room (read only). A device in the room is required to
detect the power state.

Lets you do programming when the volume of the currently-selected audio
CURRENT_VOLUME path changes in the room (requires discrete volume). Use conditional
programming.

Lets you do programming when any devices changes in the room (requires

HAS DISCRETE_VOLUME discrete volume). Use command programming.

HAS_DISCRETE_MUTE Lets you do programming when the Mute state is known (MUTE_ON or

MUTE_OFF).
IS_MUTED Lets you do programming when in Mute state (MUTE_ON).
IN_NAVIGATION Lets you do programming when On-screen is available.

Lets you do programming any time a selection changes to reset the default
USE_DEFAULT_VOLUME volume. For example, when changing from viewing a DVD to listening to
music, the volume is reset to the default discrete set volume.

DEFAULT_AUDIO_VOLUME Lets you program the default Audio volume.

DEFAULT_VIDEO_VOLUME Lets you program the default Video Audio volume.

VOLUME_IS_LINKED Lets you set programming not to affect already linked volume.
MUTE_IS_LINKED Lets you set programming not to affect already linked mute state.
ROOMOFF_IS_LINKED Lets you set programming not to affect already linked room off state.
SELECTIONS_LINKED Lets you set programming not to affect already linked selections.
ROOM_HIDDEN Iazf/sic)éc.)u set programming to hide rooms from appearing on the navigation
MEDIA_SCENE_ACTIVE Lets you set programming to set a media scene as active.

4.4.3.2 Variable Handling
In programming, Variables are easier to define than Conditional Loops.

Note: It is important to type the variable names precisely. A typographical error causes the program to
fail.

Variable-handling enhancements:

e Preserve user-defined variables—Preserves the user-defined variable values (such as the
current Dimmer light level) across a normal system restart. It may not preserve them if the
system shuts down abnormally.

e Program a system startup event —lInitializes variables or performs other programming at
system startup with a system startup event (in Programming, select the root of the project,
and then select the event When the project is loaded).
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Define one Variable to equal another—Defines one variable to equal another variable. This
can be used to save and restore variable values.

Example: The level of a light or the volume of music in a room.

After this value is saved to the variable, you can restore the system variable to the value
stored in the user variable. The system can then compare the two (2) variables and
determine if it needs to reset one of them.

Create the event “When a System reboots”—Sends an email notification to the Control4
Dealer that a customer’s system rebooted, helping the Dealer monitor the system’s
performance.

4.4.4 Using Custom Agent Variable Agent Boolean

Use the Control4® Composer HE Programming view to create custom variables in an Agent using a
Boolean value.

In this example, when someone is at the door:

Program to activate the Media Scene 'Someone is at the door,' and turn on the porch light.
Program to play a song in the Bedroom and the Theater.

When the Motion Sensor stops sensing motion at the door, program to turn the music and
porch light off.

4.4.4.1 Prerequisites

The following devices are added and identified in the project. Your Control4 Dealer or Installer can set
these up for you:

Controller

Porch Light Switch
Bedroom music
Theater music
Motion Sensor

4.4.4.2 Procedure

4.4.4.2.1 Create a New Variable Agent — Boolean
1. In Composer, click Agents.
2. Select Variable. The Variables view appears.
3. Click New.
4. On the dialog that appears, do the following:
a. Click New Variable.

b. In the drop-down menu, select Boolean.
c. Name the Variable Power State and click OK. The default value is false.
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3 Coveacind

4.4.42.2 Create a Media Scene “Someone is at the door”
5. Select the Media Scenes agent, and click New.
6. Name the Media Scene Someone is at the door. Click OK.

e e s T T
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44423 Addthe Bedroom and Theater Room
7. Click Add Room, and add the Theater and the Bedroom.
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9. Click Programming to display the Programming view.
10. In the project tree and the Device Events pane, click to expand Variables, and select Power

State.
11. In the project tree and in the Device Actions pane, click to expand Variables, and select Power
State.
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4.4.4.2.4 Addthe Conditionals and Commands
12. Click the Conditionals tab.

13. In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane.
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14. Click the Commands tab.

15. In the Commands tab, click Set to True, and drag the green arrow on top of the blue question
mark in the Script pane to make it the first subset item of the first conditional.

16. In the Device Actions pane, select Porch Light.

17. Click the Commands tab.

18. In the Commands tab, click On, and drag the green arrow on top of the blue question mark in
the Script pane to make it the second subset item of the first conditional.
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In the project tree and in the Device Actions pane, select Media Scenes.
Click the Commands tab.

Click Activate in the Commands tab, and drag the green arrow on top of the blue question
mark in the Script pane to make it third subset item of the first conditional.

In the project tree and in the Device Actions pane under Variables, select Power State.
Click the Conditionals tab.

In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane (this is
the second conditional).

Click the Commands tab.

In the Commands tab, click Set to False, and drag the green arrow on top of the blue question
mark in the Script pane to make it the first subset item of the second conditional.

In the project tree and in the Device Actions pane, select Front Light.
Click the Commands tab.

In the Commands tab, click Off, and drag the green arrow on top of the blue question mark in
the Script pane to make it the second subset item of the second conditional.

In the project tree and in the Device Actions pane, select Media Scenes.

In the Commands tab, click Deactivate, and drag the green arrow on top of the blue question
mark in the Script pane to make it the third subset item of the second conditional.
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32. In the project tree and in the Device Events pane, select Media Scenes and choose the event
Someone is at the Door.

33. In the project tree and in the Device Actions pane, select the Bedroom object. (Repeat the next
four steps for the Theater also.)

34. Click the Commands tab.

35. In the Commands tab, click Select Media.
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36. In the dialogue that appears, select the album and song that you want to play when Someone is
at the Door executes. In this example, ‘Knock Three Times' by Lynn Anderson is used. Click OK.

37. Drag the green arrow to the Script pane.
38. Repeat Steps 33-37 for the Theater.
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39. In the project tree and in the Device Events pane, select Motion Sensor under Front, and
choose the event When the Motion Sensor senses motion.

44425 Addthe Boolean Values

40. In the project tree and in the Device Actions pane, click to expand Variables, and select Power
State.

41. In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane (this
is the third conditional).

42. In the Commands tab, click Set to True, and drag the green arrow on top of the blue question
mark to make it the first subset of the third conditional.

43. In the project tree and in the Device Events pane, choose the event When the Motion Sensor
stops sensing motion.

44. In the project tree and in the Device Actions pane, click to expand Variables, and select Power
State.

45. In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane.

46. In the Commands tab, click Set to False, and drag the green arrow on top of the blue question
mark to make it the second subset of the third conditional.

Results: The Porch Light turns on and plays a song in the Bedroom and Theater whenever the
Motion Sensor senses motion at the front door.

4.4.5 Using Custom Agent Variable Agent Number

Use the Control4® Composer HE Programming view to create custom variables in an Agent using a
numeric value.

In this example, program one (1) Keypad button to toggle between turning on the Theater Dimmer
and the Theater Switch.

4.4.5.1 Prerequisites

The following devices are added and identified in the project. Your Control4 Dealer or Installer can do
this for you:

Controller

Dimmer (Theater)
Light Switch (Theater)
6-Button Keypad

4.45.2 Procedure

4.45.2.1 Create a New Variable Agent — Number

1. In Composer, click Agents.

2. Select Variables. The Variable Agents view appears.

3. Click New.

4. On the dialog that appears, do the following:
a. Select New Variable.
b. Name the variable Keypad_presses.
c. Use the Variable Type pull-down menu to select Number.
d. Click OK.
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5. Inthe Variables pane, select the variable Keypad_presses. The available variables for your
devices appear in the right pane.

6. Enter the value as O (zero).

4.45.2.2 Create an Event
7. Click Programming to display the Programming view.
8. Inthe project tree and in the Device Events pane, select 6 Button Keypad.
9. Click Button 1 on the 6 Button Keypad.
10. Select Press for the event. The event appears at the top of the Script pane.

4.45.2.3 Create the Actions

11. In the Actions pane, scroll down to view the agents.

12. Click to expand Variables.

13. Select Keypad_presses.

14. Click the Commands tab.

15. In the Commands tab, select the following to add 1 to the present value:
a. Selectthe radio button by the plus (+) sign. Ensure the plus sign is selected.
b. Select 1 (one). The action appears in the Actions pane.

16. Drag the green arrow icon to the Script pane.

4.45.2.4 Create the Conditionals
17. Click the Conditionals tab.
a. Select the Is radio button option.
b. Select equals (=) sign.
c. Select 1 (one).

18. Drag the blue question mark below the previous command in the Script pane. This places the
conditional Action parallel to the previous Action command.

19. In the Actions pane, select Theater Dimmer.
20. In the Command tab, select On. The action command appears in the Actions pane.
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21. Drag the green arrow to the blue question mark in the Script pane to make it a subset of this
conditional item.

22. In the Actions pane, scroll down to the Agents.
23. In the Variable agent, select Keypad_presses.
24. Click the Conditional tab.

a. Selectthe Is radio button option.

b. Select equals (=) sign.

c. Select 2 (two).

25. Drag the blue question mark to the blank space under the previous Action command. This
places the conditional Action parallel to the previous Action conditional.

26. In the Actions pane, select Theater Switch.
27. In the Command tab, select On. The action command appears in the Actions pane.

28. Drag the green arrow to the blue question mark in the Script pane to make it a subset of the
conditional item.
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29. In the Actions pane, scroll down to the Agents list.
30. In the Variable agent, select Keypad_presses.
31. In the Commands tab, select the following:
a. Selectthe Set to Value radio button.
b. Set the value to 0 (zero). The Action command appears in the Actions pane.

32. Drag the green arrow icon to the blue question mark icon in the Script pane to make it a
second subset of the conditional.

4.4.6 Using Custom Agent Variable Agent String

Use the Control4® Composer HE Programming view to create custom variables in an Agent using a
numeric value. Note: The steps in this section are for more advanced Composer users. This example
includes many steps.

In this example, you will program Button 4 on a Keypad to toggle through four (4) playlists.

4.4.6.1 Prerequisites

The following items are added and identified in the project. Your Control4 Dealer or Installer can do
that for you:

e Controller
e 6-Button Keypad
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4.4.6.2.1 Add a New Variable
1. In Composer, click Agents.

Select Variables. The Variables agent list appears.

2.
3. Click New.
4

On the dialog that appears, do the following:
a. Select New Variable, and name the variable My Playlists.

b. In Variable Type, use the pull-down menu to select String, and click OK.

Set Up Mom’s Favorites Playlist in the Theater

5. Click Programming to display the Programming view.

6. In Programming, select 6 Button Keypad in the Theater from the Device Events pane.
7. In 6-Button Keypad Events, click Button 4 on the Keypad.
8
9

In the Device Actions pane, scroll down and click to expand Variables.
Select My Playlists.

10. In My Playlists Actions pane, click the Conditionals tab, and enter the name of a playlist; for
example, Mom'’s Favorites.

11. Drag the first blue question mark to the Script pane.
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12. In Device Actions, select the Theater room object.
13. In Theater Actions, select Media.
14. In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.

15. Drag the green arrow icon on top of the first blue question mark in the Script pane to make it
the first subset of the first conditional.
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16. In Device Actions, select My Playlists.

17. In the Commands tab under My Playlists, enter the name of the next playlist that you'd like to
play; for example, Mom’s Favorites.

18. Drag the green arrow on top of the first blue question mark to the Script pane to make it a
second subset of the first conditional.

The next time the button on the Keypad is pressed, the value of the variable will be Mom’s
Favorites, and will then cue that playlist in the Theater.
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19. In Device Actions, scroll up, and select the 6 Button Keypad in the Theater.

20. In 6 Button Keypad Actions, click Button 4.
21. Click the square of color to choose the color you want Button 4's LED to be when Mom'’s
Favorites plays. Choose the color in the menu that pops up (in this example: green), and click

OK.
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22. Drag the green arrow on top of the first blue question mark in the Script pane to make it a third
subset of the first conditional.
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23. In Device Actions, scroll down and select Programming Control.
24. In the Programming Control Actions, select the Stop radio button.
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25. Drag the green arrow on top of the first blue question mark in the Script pane to make it a
fourth subset of the first conditional.

Note: It is important to add a Stop command here so that when the conditional is fulfilled, the
programming will not continue. Because of the way this programming is set up when it’s finished,
without the stop, the button on the Keypad will always select the last playlist in the script.
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4.4.6.2.3 Set Up Dad’s Favorites Playlist in the Theater

26. In Device Actions, select My Playlists again.

27. In the Conditionals tab, next to ‘Is’ enter Dad’s Favaorites in the text box.

28. Drag the second blue question mark to the Script pane.

29. In Device Actions, select the Theater.

30. In Theater Actions, select Media.

31. In the window that pops up, select Playlists, Dad’s Favorites, and then click OK.

32. Drag the green arrow on top of the second blue question mark in the Script pane to make it the
first subset of the second conditional.

4.4.6.2.4 Set Up Kid’'s Room Playlist in the Theater

33. In Device Actions, select My Playlists.

34. In the Commands tab under My Playlist Actions, enter the name of the next playlist that you'd like
to play; for example, Kid's Music.

35. Drag the green arrow on top of the second blue question mark in the Script pane to make it a
second subset of the second conditional.

36. In Device Actions, select the 6 Button Keypad in the Theater.

37. In 6 Button Keypad Actions, click on Button 4. Click the square of color to choose the color you
want Button 4’s LED to be when Kid’'s Music plays. Choose the color in the menu that pops up
(in this example: purple), and click OK.

38. Drag the green arrow on top of the second blue question mark in the Script pane to make it a
third subset of the second conditional.

39. In Device Actions, select Programming Control.

40. In the Programming Control Actions pane, select Stop.

41. Drag the green arrow on top of the second blue question mark to make it a fourth subset of the
second conditional.

42. In Device Actions, select My Playlists again.

43. In the Conditionals tab, enter Kid’s Music.

44. Drag the blue question mark to the Script pane to make it the third conditional.

45. In Device Actions, select the Theater room object.

46. In Theater Actions, select Select Media.

47. In the window that pops up, select Playlists, Kid’s Music, and then click OK.

48. Drag the green arrow on top of the third blue question mark in the Script pane to make it the
first subset of the third conditional.

4.4.6.2.5 Set Up Choral Music in the Theater

49. In Device Actions, select My Playlists.

50. In the Commands tab under My Playlists, enter the name of the next playlist that you'd like to
play; for example, Choral Music.

51. Drag the green arrow on top of the third blue question mark to make it a second subset item of
the third conditional.

52. In Device Actions, select the 6 Button Keypad in the Theater.

53. In 6 Button Keypad Actions, click on Button 4. Click the square of color to choose the color you
want button 4's LED to be when Kid's Music plays. Choose the color in the menu that pops up (in
this example: red), and click OK.

54. Drag the green arrow on top of the third blue question mark in the Script pane to make it the
third subset of the third conditional.
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62.
63.
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65.
66.

67.

68.
69.
70.

71.

72.
73.
74.

75.
76.
77.
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In Device Actions, select Programming Control.
In the Programming Control Actions, select the Stop radio button.

Drag the green arrow on top of the third blue question mark in the Script pane to make it a
fourth subset of the third conditional.

In Device Actions, select My Playlists again.

In the Conditionals tab, enter Choral Music.

Drag the fourth blue question mark to the Script pane.

In Device Actions, select the Theater room object.

In Theater Actions, select the Select Media radio button.

In the window that pops up, select Playlists, Choral Music, and then click OK.

Drag the green arrow on top of the fourth blue question mark in the Script pane to make it the
first subset of the fourth conditional.

In Device Actions, select My Playlists.

In the Commands tab under My Playlists, enter the name of the next playlist that you'd like to
play; for example, Mom’s Favorites.

Drag the green arrow on top of the fourth blue question mark in the Script pane to make it a
second subset of the fourth conditional.

In Device Actions, select the 6 Button Keypad in the Theater.
In 6 Button Keypad Actions, click on Button 4.

Click the square of color to choose the color you want Button 4's LED to be when Choral Music
plays. Choose the color in the menu that pops up (in this example: yellow), and click OK.

Drag the green arrow on top of the fourth blue question mark to make it a third subset of the
fourth conditional.

In Device Actions, select Programming Control.
In the Programming Control Actions, select the Stop radio button.

Drag the green arrow on top of the fourth blue question mark to make it a fourth subset of the
fourth conditional.

In Device Actions, select the Theater room.
In Theater Actions, select Media.
In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.

Note: You do this is because the first time the button on the Keypad is pushed, the string variable
does not have a value, and nothing happens. This last command is created when none of the
conditionals are fulfilled, something will play; each time the button is pushed thereafter, a conditional
is fulfilled.

78.

79.
80.

81.
82.
83.

Drag the green arrow below the previous Stop command in the Script pane. It is not a subset of
the previous conditionals, but a command on its own.

In Device Actions, select My Playlists.

In the Commands tab under My Playlists, enter the name of the next playlist that you'd like to
play; for example, Dad’s Favorites.

Drag the green arrow below the previous command in the Script pane.
In Device Actions, select the 6 Button Keypad in the Theater.

In 6 Button Keypad Actions, click on Button 4. Click the square of color to choose the color you
want Button 4's LED to be when Mom'’s Favorites plays. Choose the color in the menu that pops
up (in this example: green), and click OK
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84. Drag the green arrow below the previous command in the Script pane. You do not need a stop
at this point, because the programming automatically stops at the end of the script.

Programming with Agents

Use the Control4® Composer HE Agents and Programming views to configure Properties, Delays and
Agents.

An agent provides the ability to perform complex programming by using functional modules. Various
types of agents are available, for example, Announcements, Email Notifications, Scheduler, Lighting
Scenes, Wakeup, etc.

Example: The Scheduler agent lets you configure dates and times.
When using agents in the Programming view, you configure them in two (2) parts:

1. Inthe Agents view, you first define an instance of a type of agent.
2. In the Programming view, you use the instance of the agent for event programming.

Example: In the Agents view, you can create an instance of Custom Buttons where you identify all of
the buttons you want to create. Then, in the Programming view, you program the Custom Buttons to
perform specific tasks on your devices.

The “Agent Examples” section can guide you through the process for each type of agent available.
Agents can vary greatly in functionality.

Note: Ensure that the devices to which you want to apply the agents are added and identified in the
system. Your Control4 Dealer or Installer can help you do this.

Agent Types

Use the Control4® Composer HE Agents and Programming views to add agents to your system.

Available agents:

e Announcement—Provides the ability to play a pre-recorded .WAV file or to display a text
message whenever a given event occurs. An audio announcement can play on any audio
output device in the selected rooms. Likewise, a supporting text message or stand-alone text
message can display on the Navigators in the selected rooms. Example: You can create a
"Doorbell” announcement that will play a .WAV file (a tone or voice) and display the text
message on the Navigators, “Someone is at the front door” each time a doorbell is pressed.

e Custom Buttons—Lets you create user interface buttons to use for specialized devices on
the Navigators. See “Programming with the Room or Global Access Custom Buttons” in
“Agent Examples.”

e E-mail Notification—Lets you have an email message sent to your email address when
specified events occur as defined in programming.

Notes:
1. Remote access is required to use the Email Notification agent.
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2. Avoid setting up email notifications for events that occur frequently (such as when a
motion sensor senses motion). If the email notification trigger event occurs too often, it
will cause the system to become sluggish.

e Lighting Scenes—Provides the ability to set up a Lighting Scene. Example: By pressing one
button on a Keypad, you can turn on specific lights at set ramping levels. See “Programming
with the Lighting Scenes Agent” in “Agent Examples.”

e Media Scenes—Lets you create a scene that plays music in selected rooms on your
Control4 system.

e Macro—Macro agents associate programming with events. For example, you can create one
macro to use in several different programming events.

e Scheduler—Defines conditionals of time to the system, and adds the ability to have
scheduled events. See “Programming with the Scheduler Agent” in “Agent Examples.”

e Screen Saver—Lets you set up a Screen Saver agent So you can create various Screen
Savers.

e Timer—Provides the ability to start a timer, stop a timer, or repeat a timer based on a given
event and action. Example: If a motion sensor in the system turns on a light when it detects
motion, then a timer can be used to turn off the light after 15 minutes. Alternatively, a timer
can be set to repeat an action whenever the timer expires.

e Variables—A variable is a representation of information about the controlled devices, such
as a power state or current level of the device, and it works much like a Media Scene.
Variables provide other programming options not available by using Commands,
conditionals, or Loops. There are three (3) kinds of variables:

1. Room Variables—Provide you with additional programming options not available from
the Room object programming. Use Room object programming in preference to room
variables whenever possible.

2. Custom Variables—Let you define additional programming options using:

0 Boolean—Provides a true/false option. Example: The light level is 70 percent.
o0 Device—Provides a list of device options.

o0 Number—Provides a value option. Example: The light level is 70 percent.

o0 String—Provides the option to enter a string.

3. Container Variables—Provide the ability to bind two (2) or more devices together
using device variables. Container variables are available from the Agents view, and by
highlighting variables.

Note: Issues with various implementations have been found. The use of container
variables for future implementation is not recommended. Where possible, replace
existing implementations with alternate programming.

e Video Wall—(10.5" Touch Screens only) Creates a video wall for simultaneous viewing and
control of multiple video sources on multiple displays. A video wall is commonly used for
viewing multiple sports or news channels while in the same room and incorporates multiple
video displays and multiple cable/satellite tuners equipped with Digital Video Recorders
(DVRSs). The agent provides the ability to control these multiple video displays from the
Wireless Touch Screen.

o Wakeup—Has the ability to initiate a pre-specified wakeup time in the Navigators. The
Wakeup agent lets you play music, turn on lights, and change temperatures. See
“Programming with the Wakeup Agent” in “Agent Examples.”

Copyright © 2010 Control4. All Rights Reserved.

Saved: 6/30/2010 8:46:00 AM 200-00170_Composer HE Page 57 of 117
User Guide



5.1.1

5.1.2

Composer HE User Guide

Agent Examples

Use the Control4® Composer HE Agents and Programming views to create and apply agents to
devices in the Control4 system.

The following examples are used in the Agents-related sections of this document:
e “Programming with the Announcement Agent”
e “Programming with a Custom Buttons Agent”
e “Programming with the E-Mail Notification Agent”
e “Programming with the Lighting Scenes Agent”
e “Programming with the Macro Agent”
e “Programming with the Media Scenes Agent”
e “Programming with the Rhapsody Agent”
e “Programming with the Scheduler Agent”
e “Programming with the Screen Saver Agent”
e “Programming with the Timer Agent”
e “Programming with the Variables Agent”
e “Programming with the Video Wall Agent”
e “Programming with the Wakeup Agent”

Note: Ensure that the devices to which you want to apply agents are added and configured in the
system. Your Control4 Dealer or Installer can help you do this.

Programming with the Announcement Agent
Use the Control4® Composer HE Agents and Programming views to program this agent.

You can create an announcement that

1. Displays a text-message or Web page on any of the Graphical Navigators (TV on-screen menu,
Touch Screens, or LCD Keypad),
2. Plays a WAV-formatted audio announcement through any audio endpoint, or

3. A combination of the two.

Note: The Control4 system allows up to 10MB of files for the Announcement agent, and plays a
maximum of 15 seconds per announcement.

Example: Create a 'Dinner is Ready' announcement that is activated when the family chef presses a
custom-programmed button. When the button is pressed, the text message “Dinner is ready” displays
on all of the On-Screen Navigators and Touch Screens in the home, while an audio file plays a dinner
bell ringing.

5.1.2.1 Prerequisites

1. Ensure that the devices to which you want to apply agents are added and identified in the system.
Your Control4 Dealer or Installer can help you do this.

2. For this example, ensure the project tree includes the following devices:
e A Controller
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e An audio output device (such as a TV or connected speakers)
e A Navigator with a screen (Touch Screen, TV, or LCD Keypad)

e Any device involved in the triggering event (such as a Doorbell Contact, 3-Button Keypad.
etc.)

5.1.2.2 Procedure
To set up an Announcement agent:
1. Start Composer and connect to a Director.
2. Click the Agents view.
3. (Initial Announcement Agent only) Click Add.
4

In the Agents pane, select Announcements, and then click OK to add Announcements to the
Available Agents list in the project. The next time you want to create an announcement, select the
item in the Agents pane, and then click New.
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5. With Announcements selected in the agents <name> pane, click New.
6. Add a name to the new announcement, and then click Create.
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7. Set up the Navigator text message to be displayed.
e Check the Display Navigator Text/Image Popup box.
e Click Edit Text/Image.

!

Image

No
Image

(&) Text

) Variable

@) File
O URL

Teut Message

-

v Add Delete.

o Enter a text message, a URL, or browse to an image (JPG, GIF, or PNG) to be displayed.

The text box accepts any HTML code. While certain links and scripts won’t be handled, when the
announcement is triggered, for example, if you put this text in an announcement, it will show up
just as if it were a Web page.

The following text will display the latest snapshot of a Web page:

<HTML><BODY><IMG
SRC=""http://tbn0.google.com/images?g=tbn:1uOhCnlc3zbQgM:http://www.inkycircus.com/jargo
n/images/mountain.jpg" ALT="pumpkin'"><a href=""http://www.w3schools.com/*">Visit
W3Schools!</a></BODY></HTML>

Note: A static image file (JPG, GIF, or PNG) only has to be added to your project one time,
because it is copied to the Controller. When added, it is available in the Text Message drop-down
list for use in any additional announcements created.

e Select the time you want the text message to display by selecting a Close after drop-down
option (supported display times are from 5 seconds to 10 minutes).

e Click Add/Remove and add the Navigators that will display the message. Click OK.
8. Audio file. Add a WAV audio file and set up the audio file to play.
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a. Check the Play Audio File (WAYV) box.

b. (One time per audio file.) Click Add and browse to the .WAV audio file to add it to the drop-
down list.

Note: An audio file only has to be added to your project one time, because it is copied to the
Controller. When added, it is available in the Audio File drop-down list for use in any
additional announcements created.

c. Choose the WAV file from the drop-down list.

d. Click Add/Remove Rooms and add the rooms where the audio file will play.
e. Set the volume of the audio play for each room.

Note: Volume for the announcement can be set only on devices with discrete volume control.
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9. Click the Programming view.
10. Verify that the new Announcement Agent displays in the Actions list (bottom of list).
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a. Select Announcements.

b. Make sure the '‘Come to Dinner!' message displays in the Announcement Actions pane, and

that the command is there (green arrow).
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11. Program the announcement to play or display with a triggering event.

Example: Program a button-press event (left pane) to trigger the Announcement agent “Dinner is
ready” (right pane) to run.

5.1.3 Programming with a Custom Buttons Agent

Use the Control4® Composer HE Custom Buttons Agent to create up to four (4) custom screens to
display on the Navigators (including Touch Screens and On-Screen devices).

Example: If you have a heated driveway or some other specialty device, you can set up a screen with
custom buttons to operate the heated driveway from your Navigators.

5.1.3.1 Guidelines

e You can access each screen on the Navigators from the Control4 main menu or for a room
from four (4) available tabs. For example, the heated driveway screen is accessed from a
custom tab on the main menu. You can configure the tab to be viewed system-wide on all
screens, or to view in one room.

o The Navigators allow up to four (4) tabs per room to access custom screens with custom
buttons. Each screen can provide up to six (6) custom buttons for a total of 24 custom
buttons. The four (4) tabs in each room can be allocated either as room or global tabs.

e On the Navigators, you can set up a room or global tabs. The example shows the creation of
custom tabs that appear in the Front room to access a custom screen.

Note: If you want to create a Custom tab to appear globally, check the Global box next to the
Screen Name. Because only four (4) screens are available for each room, if a Global button is
added and another room already has four (4) screens, the Global button replaces the first screen
in that room.

5.1.3.1.1 Prerequisites
The following devices are added and identified (with a network address) in the project:
e Controller

e Electronic Gate (In the Control & Audio Video Connections tab, ensure that the Electronic
Gate is connected to Controller Relay Port 4.)

5.1.3.1.2 Procedure
To set up a Custom Buttons agent:
Start Composer and connect to a Director.
Click Agents.
In the Agents view, click Add to choose an agent type Custom Buttons.
When the dialog appears, choose Custom Buttons.
Click OK.
Select the Custom Buttons agent.
From the list that appears in the left pane, select the room for the Custom Button.
Select Front.

© N AWM
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9. When the Custom Buttons interface appears, in the Screen 1 area, click Add.
10. Enter the name of the buttons to appear on the Navigator screen.

- [E==3 ==Y ]
Lo, Bamora.
| |

[

3l b |

Br= = C=

11— — I

[ r—

11. Enter the relevant information for the device.

The Screen Name is the name that appears on the access tab to enter the custom screen. The
buttons are the names that appear on the custom buttons.

Example: For the Electronic Gate, enter the following:

e Screen Name: Electronic Gate
e Button 1: Toggle

12. Click OK.
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13. Click the Programming view to program your Custom Buttons.
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14. In the Device Events pane, scroll down to the agents and select the Custom Buttons agent.

15. In the Custom Buttons Events pane, ensure that Front-Electronic Gate is selected under the
Event Screen next to Toggle, and then select the Press radio button. When custom button
‘Toggle’ on screen ‘Electronic Gate’ in Front is pressed, it appears at the top of the Script pane.
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16. In the Actions pane, select Electronic Gate.

17. From the Command tab, select the Toggle the Electronic Gate radio button. The action
command appears in the Actions pane.

18. Drag the green arrow to the Script pane.

19. Select File > Refresh Navigators.

Programming with the E-Mail Notification Agent

IMPORTANT: An active 4Sight Internet Service subscription is required for Email Notification to work.
See Composer HE Getting Started or the Control4 System User Guide for details.

Use the Control4® Composer HE E-Mail Notification Agent to have an e-mail sent to an e-mail address
automatically when specific events occur that you define in programming.

Example: If you want to know when the Basement door opens, you can set up an E-mail Notification
agent to send an e-mail to your e-mail application’s Inbox when the Basement door is opened.

e The E-mail Notification agent is a Control4 service. To use the E-mail Notification agent,
Remote Access is required to facilitate a secure connection between the Controller and the
Control4 service.

e The E-mail Notification agent uses templates to enhance usability. You can use a template to
define a To, Subject, or Body for use when creating instances of the Email Notification agent.
See "Connecting to a Director" or "Setting Up Remote Access" in Composer HE Getting
Started.

e Use the Programming view to define the individual instance that triggers an e-mail and
completes the definition.

Example: A security threat to the house notified you of broken windows, doors opening, and motion
detected in Away mode. In the template, you define Subject: Security Alert and To:
fsmith@myemail.com. In the Programming view, you might define the zone. Examples of other
incidents to use E-mail Notification include: Basement Door Opened, Front Gate Opened, Water
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5.1.4.1 Prerequisites

The following example devices are added and identified (with a network address) in the project:
e Controller
e Door Contact Sensor

5.1.4.2 Procedure

To set up an E-Mail Notification agent:

1. Start Composer and connect to a Director.

2. Click Agents.

3. Inthe Agents view, click Add to an agent type.

4. When the dialog appears, select Email Notification.

5. Click OK.

6. Select Email Notification, and click Add in the pane that follows. The New Template Name
dialog appears.
Tip: Control4 now includes Control4 system and user-defined variables in the templates created
using this agent. To use this function, your Control4 Installer can create or modify e-mail
templates using Composer HE, Agents, Email Notification, and then use the Add Variable
option.

7. Enter a name on the dialog that appears, for example, 'Security Alert.'

8. Click Create.

9. In Email Notification Template Name, select Security Alert for the Composer email screen to
appear.

10. Fill out the information for the email you want sent to you when an event occurs.
Example:
To: fsmith@myemail.com
Subject: Security Alert
Body: The security of the Franklin Smith House may have been compromised.
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Sensor detection, Carbon Monoxide Sensor detection, Motion Sensor detection, Sprinklers On/Off,
etc.

Tip: When setting up an Email Notification agent, note the frequency that an event can happen,
because if it is too frequent it can slow down the system. For example, if an e-mail is sent when a
motion sensor detects motion, the frequent email messages could cause sluggishness.
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11. Do the following as needed:
a. Click Send Email to test whether you receive an email to your email address.
b. Click Save to exit and go to the Programming view to set up the programming.
c. Click Reset to clear the To, Subject, and Body of the email to start again.

12. With the Agent template created, you can create one instance of the Security Alert for each security
zone (or object).

13. Click Programming to display the Programming view.
a. In Programming under Theater, select Door Contact Sensor.
In Door Contact Sensor Events, select When Door Contact Sensor opens.
In the Actions pane, scroll down and select Email Notification.
Make any changes to the e-mail as necessary.
. Drag the green arrow to the Script pane.
14. In the File menu, click Refresh.

15. Test the Email Notification agent by going to the door and opening it. An e-mail is sent to your
Inbox with the Security Alert as a subject.

® oo o

5.1.5 Programming with the Lighting Scenes Agent

Use the Control4® Composer HE Agents and Programming views to set up a Lighting Scene agent.
Lighting Scenes let you set up lights in your home to pre-determined settings and ramp rates.

Example: Set up the Bedroom Dimmer and Theater Dimmer to a pre-determined level and ramp rate
when they are turned on. Turn the Dimmer off and on.
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5.1.5.1 Prerequisites

1. Ensure that the devices to which you want to apply agents to are added and configured in the
system. Your Control4 Dealer or Installer can help you do this.

2. Ensure the project tree includes the following devices:
e Controller
e Theater Dimmer
e Theater Switch
e 6-Button Keypad
e Bedroom Dimmer

5.1.5.2 Procedure

To set up a Lighting Scenes agent:

1. Start Composer and connect to a Director.
2. Click the Agents view.

3. Click Add to add an agent type.

Diveeion Statur idde

4. When the dialog appears, select Lighting Scenes.
5. Click OK.

6. Highlight Lighting Scenes and click New. The Lighting Scene interface appears.
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7. Enter a name for the Lighting Scene on the dialog that appears, such as Evening Lights.

8. Click Create.
9. The instance of the agent you created appears. Highlight the instance you just created, and click

Add/Remove Load to continue.

G bt Pt | i e

T

10. Check the lighting loads for the Theater Dimmer, Theater Switch, and Bedroom Dimmer you want
to add to the scene, and then click OK.
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11. Set the desired settings for each load:
e Dimmer Options

e Level—Lets you set a lighting level as appropriate by using the bar or Level pull-down
menu, such as 50 percent for the Bedroom Dimmer and 20 percent for the Theater
Dimmer.

e Ramp Rate—Lets you set the Ramp Rate, which is the speed used to get to the specified
level. Use the pull-down menu to set the Milliseconds, Seconds, or Minutes of the ramp
rate. Then set the amount of time you want for the level to change. Example: Set the time
to 1 second for both the Bedroom Dimmer and the Theater Dimmer.

e Remove Load—Lets you remove this particular load by clicking Remove Load.

e Switch Options—You can turn the light on or off for the Lighting Scene. Example: Turn the
light Off.

12. When you finish setting the Lighting Scene for each load, click Execute Scene.
Note: Other buttons may apply as needed.

e Add/Remove Load. Click to add or remove Dimmers or Switches. Select the Dimmer or
Switch from the tree and click OK.

e Execute On Scene. Click to have all Dimmers and Switches in this scene turn on when
executed.

e Execute Off Scene. Click to have all Dimmers and Switches in this scene turn off when
executed.

e Sync This Scene. Click to synchronize the behavior of the devices in this scene. Used
mostly for updates and testing.

e Sync All Scenes. Click to synchronize the behavior of all devices in all scenes. Used mostly
for updates and testing.
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13. A dialog appears that the scene is executed. Click OK.
14. Click the Programming view.
15. In the left pane, highlight the device to program.
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Example: 6 Button Keypad

16. In the left middle pane, click the top right button (Button 4).
17. Select Press as the event to trigger and program. The event appears at the top of the Script

pane.
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18. From the Actions pane, scroll down to view the available agents in the project.

19. Highlight the agents that you want to configure.

Example: Lighting Scenes
The available commands appear in the Lighting Scene Actions pane and Commands tab.
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20. Select the command to view it.
21. Drag the green arrow to the Script pane.
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22. Press Button 1 on the 6 Button Keypad, or click Execute in the Script pane to test the Lighting
Scene.

5.1.6 Programming with the Macros Agent

Use the Control4® Composer HE Agents and Programming views to program this agent. Macro
agents associate programming with events. For example, you can create and name a macro to use in
several different events. You can bring the macro in from a particular program in the Programming
view > Programming Actions pane.

You can create macros agents:
e To use in various programmed events
e To use in custom pages
e To embed directly into the Navigators
See your Control4 Dealer or Installer for more information.

5.1.6.1 Prerequisites
The following devices are added and identified (with a network address) in the project:
e Controller
e Light Switch
e Navigator with a screen (Touch Screen, LCD Keypad, Television)
e Any device involved in the triggering event (Doorbell Contact, 3-Button Keypad, etc.)
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5.1.6.2 Procedures
To set up a Macros agent:

1.
2.
3.
4,

Start Composer and connect to a Director.

Click Agents.

(Initial Macro agent only) Click Add.

Select Macros, and then click OK to add the agent types list to the project.

To create a new Macros agent:

1.
2.

Select Macros in the Agents pane, and click New.
Name the new macro, for example, Bob, and then click Create.

To add the agent's programming script:

In this script, select the Living Room Right Switch which is on, and then turn off everything in the
Living Room.

7.

Click the Programming view.

In the Device Events pane, scroll down to Macros and select Bob. "When Bob is executed"
appears in the Script pane.

In the Device Actions pane, select Living Room and the Right Switch.

Drag the green arrow 'Living Room ->Right Switch->LIGHT_STATE=True' to the Script pane.
In the Device Actions pane, select Living Room.

Drag the green arrow 'Turn off Living Room' to the Script pane.
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You can add this agent to many programs that you create if you want to perform similar tasks, or
you can program the agent for a specific device. For example, you can assign this agent to Button
1 on a 3-Button Keypad to run the program when executed.

Note: A unigue Macros agent cannot be edited or copied; only created or deleted. If you want to
create a new Macros agent based on another one, you must create a new Macros agent.
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5.1.7 Programming with the Media Scenes Agent

Use the Control4® Composer HE Media Scenes agent to allow simpler multi-zone audio control.
Media Scenes link source, volume, and room-off commands. With Media Scenes, you can configure
one or more rooms in a system to play the same music at the same volume.

Example: A Media Scene for the entire house can include all the rooms in the Control4 system.
Another Media Scene can include only the Master Bedroom and Bath. You can create any number of
Media Scenes for any number of rooms.

5.1.7.1 Guidelines

1. To activate a Media Scene successfully (with the rooms being controlled simultaneously), activate
the Media Scenes agent before starting any music playback.

2. Media scenes are persistent; when activated, a Media Scene remains active until deactivated or
until the Controller is powered down. If a Media Scene is deactivated while music is playing, the
music continues to play in the associated rooms, but the rooms are no longer controlled in unison.
Therefore, music can be stopped in one room while it continues to play in another room.

3. You can set up the Media Scene one time, and activate it when desired. Then play the music.

5.1.7.2 Procedure
To create a Media Scenes agent:
Start Composer and connect to a Director.
In the Agents view, click Add.
On the dialog that appears, click Media Scenes, and then click OK.
In the Agents pane, select Media Scenes, and click New.
Enter a name for your new Media Scene. Example: Party Music.
In the Agents pane, select Party Music, and then click Add Room in the Media Scenes pane.

I A

";l:—np—.

[
i i

i v

7. The dialog box lists the rooms in your system. Check the rooms where you want to play your
Party Music, and then click OK. Example: Theater and Front.
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Tips: To remove a room from a scene, click Remove Room. To create another Media Scene, return

to Step 1.
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Tip: You can add all rooms on a floor by clicking Main. This automatically selects all other rooms in
that category. You can include also all rooms in your entire system in the Media Scene by clicking
House.

The rooms you selected appear in the new Media scene 'Party Music.'

8. To activate the scene, click Activate Scene at the top of the screen.
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To deactivate the scene, click the Deactivate Scene button.

9. You can program a button for your Media Scene. Do this by creating a new Custom Buttons agent.

10.
11.

12.
13.

14.
15.
16.

17.
18.

19.

a. Inthe Agents view, click Custom Buttons, and then below, click a room. In the Custom
Buttons pane, click Add.

b. Inthe Add Screen dialog that appears, enter the name of the Custom Button, and then click
OK.

Example: Click Theater and call the Screen name Media Scene. Name Button 1: On/Off.

The Custom Button name appears in the pane.

Click the Programming view.

In the Device Events pane scroll down, and click Custom Buttons. In the pane below, Custom
Button Events, select the screen you want to program, and then select the Press radio button.

Example: Select the screen Theater - Media Scene, and then select the Press radio button.

In the Actions pane, select Theater.

In the Theater Actions pane under Conditionals, press the Media Scene Active button, and then
the True button.

Drag the blue question mark to the Script pane.
In the Actions pane, scroll down and select Media Scenes.

In the Media Scenes Actions pane under Commands, press the Deactivate button, and then
select Party Music.

Drag the green arrow on top of the blue question mark in the Script pane.

In the Actions pane, scroll up and select Theater. In the Theater Actions pane and in
Conditionals, press the Media Scene Active button, and then the False button.

Drag the blue question mark to the Script pane.
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20. In the Actions pane, scroll down and select Media Scenes. In the Media Scenes Actions pane
and in Commands, press the Activate button, and then select Party Music.

21. Drag the green arrow icon on top of the blue question mark in the Script pane.
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The Script pane now reads, 'When custom button ‘On/Off’ on screen ‘Media Scene’ in Theater is
pressed...Activate scene ‘Party Music.'

22. To execute the scene, click Execute.

5.1.8 Programming with the Rhapsody Agent

Use the Control4® Composer HE Agents view to activate or disable a Rhapsody® agent.

Note: Rhapsody is a subscription-based music service that gives you unlimited access to a catalog of
millions of full-length, CD-quality tracks. You can listen to any Rhapsody album, songs, or playlists
whenever you want, in any room of your house through the Control4 system.

5.1.8.1 Prerequisites

1. Ensure that a Rhapsody account has been set up. See "Registering the System on
my.control4.com" in Composer HE Getting Started or your Control4 Dealer or Installer for details.

2. Ensure that the devices you want to use for Rhapsody output are added and identified to the
system.

Procedure

To activate a Rhapsody agent:

1. Start Composer and connect to a Director.

Click Agents.

(Initial Rhapsody agent only) Click Add.

Select Rhapsody, and then click OK to add Rhapsody to the agent types list in the project.

With Rhapsody selected in the left pane, click New. The following dialog box appears in the right
pane.

5.1.8.2

a kM wD
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Account Properties

Dizplay Hame | My Rhapzody
Account Mame

Account Pazsword

[] Remember Paszword

[ Save ] [ Reset ] [ Activate ]

6. Enter your Rhapsody account name and password.
7. Click Save.
8. Click Activate.

To disable Rhapsody:

1. Start Composer and connect to a Director.
2. Click Agents.

3. Select Rhapsody from the agents list.

4. Select Disable Rhapsody.

Programming with the Room or Global Access Custom Buttons

Use the Control4® Composer HE Agents and Programming views to create custom buttons for display
on your Navigators. The Custom Button Agent lets you create up to four (4) custom screens to display
on the three (3) Navigators (Mini Touch Screen, On-Screen, and Wireless Touch Screen - 10.5).

Example: If you have a heated driveway or some other specialty device, you can set up a screen with
custom buttons to operate the heated driveway from your Navigators.

Each screen is accessed from the main menu or from a room from four (4) available tabs. For
example, the heated driveway screen is accessed from a custom tab from the main menu. You can
configure the tab to be viewed system-wide on all screens or to be viewed in only one room.

The Navigators contain up to four (4) tabs per room to access custom screens using custom buttons.
Each screen can provide up to six (6) custom buttons for a total of 24 custom buttons. The four (4)
tabs in each room can be allocated either as room or global tabs.

Note: On the Navigators, you can set up room or global tabs. The example shows the creation of
custom tabs that appear in the Front room and access a custom screen. If you want to create a
Custom tab to appear globally, check the Global box next to the Screen Name. Because only four (4)
screens are available for each room, if a Global button is added and another room already has four
(4) screens, the Global button will replace the first screen in that room.

5.1.9.1 Prerequisites

1. Ensure that the devices to which you want to apply agents to are added and configured in the
system. Your Control4 Dealer or Installer can help you do this.
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Ensure the project tree includes the following devices:
e Controller
e Electronic Gate

5.1.9.2 Procedure
To program using the Custom Buttons agent:

1.

Sl S

6.

Start Composer and connect to a Director.

Click the Agents view.

Click Add. To choose an agent, type Custom Buttons.
When the dialog appears, choose Custom Buttons.
Click OK.

o Compmar Horss | drar

) v bl

Highlight the Custom Buttons agent.

7. Select the room where you want the Custom Button to appear from the list in the left pane.

8.

Highlight Front.
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9. When the Custom Buttons interface appears, in the Screen 1 area, click Add. In the next few

steps, you enter the name of the buttons you want to appear on the Navigator device screen you
are creating.

10. Enter the relevant information for the device.

The Screen Name is the name that appears on the access tab to enter the custom screen. The

buttons are the names that appear on the custom buttons. For example, using the Electronic
Gate, enter the following:

Screen Name: Electronic Gate
Button 1: Toggle

11. Click OK.

o) o
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12. Click the Programming view to program your custom button.
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13. Under Device Events, scroll down to the agents and highlight the Custom Buttons agent.

14. In the Custom Buttons Events pane, ensure that Front- Electronic Gate is selected under
Screen next to Toggle.

15. Select the Press radio button.

The event ‘When custom button ‘Toggle’ on screen ‘Electronic Gate’ in Front is pressed’ appears
at the top of the Script pane.
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16. Under the Actions pane, highlight Electronic Gate.
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17. Click the Commands tab.
18. Select the Toggle the Electronic Gate radio button. The action appears in the right middle pane.
19. Click and drag the green arrow to the Script pane.
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20. From the File menu, select Refresh Navigators.

Try the On-Screen Navigator or another Navigator to see the Custom Button you just created.

5.1.10 Programming with the Scheduler Agent

Use the Control4® Composer HE Agents and Programming views to create a Scheduler agent. The
Scheduler agent lets you schedule time on the system to trigger events. You have the flexibility to
program a specific one-time event, multiple events to re-occur daily, weekly, monthly, yearly, etc.

Example: Schedule a fun event to wake up dad by playing his favorite song at 7:30 AM on his
birthday.

5.1.10.1 Prerequisites

1. Ensure that the devices to which you want to apply agents are added and identified in the system.
Your Control4 Dealer or Installer can help you do this.

2. Ensure the project tree includes the Controller.

5.1.10.2 Procedure
To create a Scheduler agent:
1. Start Composer and connect to a Director.
2. Click the Agents view.
3. Click Add for the Available Agents screen to appear.
4. Select Scheduler > OK.
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5. Inthe Agents pane, select Scheduler. The Scheduler interface panes appear.
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6. Inthe Scheduler pane, click New.
7. Inthe New Event dialog, enter the relevant information for this Scheduler instance:
a. Enter the Name Dad’s Birthday.
e InTime:
Select the Time radio button.

Highlight the hour: 07, minutes: 30, and AM. Use the drop-down list to select each time
separately.

¢ In Start Date, select one of the following:
Select the Start radio button. Use the drop-down list to select today's date.
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Select Start on the radio button to choose an exact day, month, and year. Use the drop-
down lists to make your selections.

e Select Repeats:

Select Yearly. Example: You want dad’s favorite song to play at 7:30 AM. This dialog lets
you schedule one-time events and recurring events.
Select Stop on, and use the drop-down list to select a month and year to stop this agent.
b. Click OK. The event is now added to the list of events.
c. To delete an event, select the event in the list, and click Delete.

o Composer Home Edition
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Email Notification
Lighting Scenes
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8. Click Programming to display the Programming view.
9. Inthe Device Events pane, select the Scheduler object at the bottom of the list.
10. In Scheduler Events, click Dad’s Birthday event. The Script pane shows Dad's Birthday event.
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11. Choose the Device Actions to initiate in the Actions pane.

12. Drag the actions to the Script pane. These scripted actions execute when Dad's Birthday event
executes.

13. You can use the Scheduler agent in programming also to add Conditionals or Loops to your
scripts.

14. In the project tree (left pane), select the 3 Button Keypad.
a. Inthe Actions pane, scroll down and select the Scheduler agent.
Click the Conditionals tab, select Time, and Within 5 minutes before Sunset.
Drag the blue question mark to the Script pane.
In the project tree (right pane), select the light.

Click the Commands tab, select turn the room on, and drag the green arrow on top of the
blue question mark in the Script pane.

® 20O

When the top button of the 3 Button Keypad is pressed, if it is within 5 minutes before sunrise, the
light comes on. The Scheduler agent lets you define one-time events and recurring events.

5.1.11 Programming with the Screen Saver Agent
Use the Control4® Composer HE Agents view to set up a Screen Saver agent.

5.1.11.1 Prerequisites

Ensure that the devices you will use to set up a screen saver and store your photos (for example, a
network-attached storage) are added and/or identified to the Control4 system. Your Control4 Dealer
or Installer can help you do this.

5.1.11.2 Procedure
To set up a Screen Saver agent:
1. Start Composer and connect to a Director.
2. Click Agents.
3. (Initial Screen Saver agent only) Click Add.
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4. Select Screen Saver, and then click OK to add Screen Saver to the agent types list in the project.
The next time you want to create a Screen Saver, click the Screen Saver item in the Agents pane,
and then click New.

5. With Screen Saver selected in the left pane, click New.
6. From the drop-down menu, select the File Storage Location.
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To find out more about setting up a custom screen saver on your Navigators, see the Control4
System User Guide.

5.1.12 Programming with the Timer Agent

Use the Control4® Composer HE Agents and Programming views to set up a timer. A Timer agent
provides the ability to start a timer, stop a timer, or repeat a timer based on a given event and action.

Example: A motion sensor in the system turns on a light when it detects motion, and then a timer is
used to turn off the light after 15 minutes. Alternatively, a timer can be set to repeat an action
whenever the timer expires, such as a Bathroom fan that restarts each time the light switch is turned
on.

5.1.12.1 Prerequisites

1. Ensure that the devices to which you want to apply the agents are added and configured in the
system. Your Control4 Dealer or Installer can help you do this.

2. Ensure the project tree includes the following devices:
e Controller
e Any device involved in a triggering event (such as a sensor for a motion detector)

5.1.12.2 Procedure
To set up a Timer agent:
1. Start Composer and connect to a Director.
2. Click the Agents view.
3. (Initial Timer Agent only) Add Timer to the list of types of agents in this project:

a. Click Add.
b. Highlight Timer Agent.
c. Click OK.

4. With Timer Agent highlighted in the left pane, click New.
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5. Type the name of the new Timer (such as Bathroom Fan), and click Create.

6. In Interval, use the drop-down list to set the timer in seconds, minutes, or hours (hh:mm:ss), and
then click OK.

7. Click Start to start the timer.
8. Click the Programming view.

9. Highlight the Timer Action (upper-right of screen), and ensure the new Timer Actions display in
the Commands tab (Start, Reset, and Stop in lower-right of screen).

Device Actions

& Programring Contral ~
& Announcemerts

O Media Scenes

l:’ Syatem Diagnostics

& Email Motification

& Lighting Scenes

& Remote Access

qﬂ Rhapsody

& Scheduler

& Screen Saver

& Timer

\.ﬂ Update Manager

& wakeup

<

Tirmer Actions

|§| Start Timer "Bathroom Fan®

Commands I Conditionals

Select Timer: | Bathroom Fan hd

(%) Start Timer 'Bathroom Far'
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) Reset Timer 'Eathroom Fan'
() Change 'Bathroom Fan' Interal

Interval: I:I
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wnning timer to uze new interyal,

10. Start, Restart, or Stop the timer as needed.
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The following table outlines how the timer behaves depending on the state of the timer when a
command is executed.

Commanig =i And Timer is ... Then Event Affect on Timer
Start Running None Restarts

Reset Stop and Start Restarts

Stop Stop Stops

Start Not Running Start Starts

Reset Start Starts

Stop Stop Stops

Examples:

¢ When you execute a Start command through programming on a running timer, no event is
fired and the time is restarted.

¢ When you execute a Start command through programming on a timer that is not running, the
Start event is fired and the timer starts.

e When you execute a Reset command through programming on a running timer, the Stop and
Start events are fired and the time is restarted.

e When you execute a Reset command through programming on a timer that is not running,
the Start event is fired and the time is restarted.

11. Program to connect the timer to an event and action, and choose to Start, Restart, or Stop the
timer.

5.1.12.3 Example Screens

See the example screens that follow. Notice how the timer is first used as an action, and then as an
event.
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Event Screen:

File Driver Go Tools Help

Programming

afb Prograrrming Control
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-8 Email Motification
m@ Lighting Scenes
EICD Remote Access
@@ Rhapzody

afb Scheduler

m@ Screen Saver
EICD Tirner
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Select Timer: | Bathroom Fan w |

3 When Timer 'Bathroom Fan' expires
(&3 When Timer 'Bathroom Fan' has been stated

3 When Timer 'Bathroom Fan' has been stopped

Status: o Stopped
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5.1.13 Programming with the Variables Agent

Use the Control4® Composer HE Agents view to set up a Variables agent. Ensure that the devices
you want to use for variables are added and identified to the system.

Variables provide other programming options not available using Commands, conditionals, or Loops.

There are three (3) types of variables you can use:

1. Room Variables—Provide you with additional programming options not available in the room
object programming. Use Room object programming as a preference to room variables whenever
possible. See “Using Room Variables.”

2. Custom Variables—Let you define additional programming options using:

Boolean—Provides a True/False option. For example, the light is on or off. If the light is on, it is
True. If the light is off, it is False.

Device—Provides a list of device options.
Number—~Provides a value option. For example, the light level is 70 percent.
String—~Provides the option to enter a string.

To program using a custom variable, in the Agent view select Variable and click New to set up a New
Variable.

Example: Use one (1) Keypad button to toggle between turning on the Theater Dimmer and the
Theater Switch.

3. Container Variables—Provide the ability to bind two (2) or more devices together by using the
device variables. A variable is a representation of information about the controlled devices, such
as a power state or current level of the device. It works much like a Media Scenes agent.
Container variables are available in the Agent view by selecting Variables.
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Note: Container variables are provided only for backward capability in Release 1.3 and subsequent
releases. Issues with various implementations have been found. The use of Container variables for
future implementations is not recommended. Where possible, replace existing implementations with
alternate programming.

5.1.14 Programming with the Video Wall Agent

Use the Control4® Composer HE Video Wall agent to create a Video Wall for simultaneous viewing
and control of multiple video sources on multiple displays.

A video wall is commonly used for viewing multiple sports or news channels in the same room. It
incorporates multiple video displays and multiple cable/satellite tuners equipped with Digital Video
Recorders (DVRs). The agent provides the ability to control these multiple video displays with the use
of the Wireless Touch Screen.

Example: You can have a Video Wall with multiple video displays (center, left, and right) and the
same number of satellites with the same functionality, service, and set of channels. You can use the
Video Wall for replaying sports, news, or any user-specified set of channels, including full-control of
the Video Wall through a single interface—the Wireless Touch Screen.

The following hardware is required to use the Video Wall agent:
e Controller and Navigator—Control4 Home Controller and Wireless Touch Screen.

e Video displays—One center and multiple auxiliary displays. A total of three (3) displays are
supported, including screens, televisions, and video monitors.

e Video sources—Cable/Satellite tuner for each monitor. Each must provide the same
broadcast on the same channel, e.g., ESPN is on Channel 110. For instance, each must
have DVR capability.

e Video switching capability—The video source received on each video display can switch
between each of the video displays. This traditionally is done using a video switching device,
but can be accomplished using modulators also.

e Audio output capability—A mechanism to provide audio signal output for the center display.
This is accomplished through the use of receivers and speakers.

Example: The following configuration steps include: three (3) Televisions, three (3) Satellite systems,
one (1) Receiver, and one (1) Controller as shown.
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5.1.14.1 Prerequisites

Ensure that your Control4 Dealer or Installer has added and identified the video wall devices to the
system.

To add a Video Wall agent:

1.

ok wbn

In Composer, click Agents.

In the Agents pane, click Add.

On the dialog that appears, select Video Wall and click OK.
In the Agents pane, select the Video Wall.

In the Ultimate Sports Agents pane and in the Channel pane, select the channels you want
available. Click Add to add them to the “Display these channels List.” This is similar to adding
them to a “Favorite’s” list. The list you create is used for each monitor.

Using the three (3) panes at the bottom, use the pull-down menus to select the Location, Video
Source, and Starting Channel for each monitor.
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5.1.15 Programming with the Wakeup Agent

Use the Control4® Composer HE Agents and Programming views to program a Wakeup agent. The
Wakeup agent lets you set wakeup times, lighting, music, and so on.

Note: Wakeup times set in Composer HE synchronize with the Navigators. Likewise, wakeup times
changed on the Navigators will synchronize with Composer.
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Example: At a specified time in the Navigators, in the Bedroom start playing music from a CD and
ramp up the light progressively from 10 to 70 percent light level in 15 minutes. Thirty minutes before

wakeup starts, set the temperature in the room to 72 degrees. After 15 minutes of playing music, turn
on the TV and play the Local News.

5.1.15.1 Prerequisites

1.

w

Ensure that the devices to which you want to apply the agents are added and configured in the
system. Your Control4 Dealer or Installer can help you do this.

Ensure that you can play music in the project.
Schedule a wakeup time. See “Programming with the Scheduler Agent” for details.
Ensure the project tree includes the following devices:

Controller

Digital Audio
Bedroom Dimmer
Gas Fireplace

5.1.15.2 Procedures
To program using a Wakeup agent:

1. Start Composer and connect to a Director.
2. Click the Agents view.

3. Click Add for the Available Agents screen to appear. Select Wakeup > OK.
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4. Highlight Wakeup. The Wakeup panes appear.

Saved: 6/30/2010 8:46:00 AM 200-00170_Composer HE

Copyright © 2010 Control4. All Rights Reserved.

Page 95 of 117
User Guide



Composer HE User Guide

At o e

Pl 1 e
f = ] P ——

iy sl a1y

|

L e e e T

T Y 0 (= S—|

[T | regeresba e 2 T
A [ o merwien
g W e

- f & ks sl g

Wk T B sl i il
=
E
o e

5. Click New.
6. On the dialog that appears, enter a name.

Example: Bedroom Wakeup

7. Click Create.
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8. Enter Wakeup Scene 1 information.

a. Media—Click Pick Media. Checked by default. Use the drop-down list to select Albums, and
then click a particular album and song you want to play when the Wakeup starts, such as
Norah Jones “Sunrise.” Set the desired volume using the scrollbar or the drop-down list.
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b. Lights—Use the scrollbar or set the Light Level to 70, and use drop-down list to set the Ramp
Rate to 15 minutes.

c. Temperature—Set the temperature to 72 degrees Fahrenheit to come on 30 minutes before
Wakeup starts.
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9. Enter Wakeup Scene 2 information.

a. Scene 2—Check Wakeup Scene 2 and set the Start time to 15 minutes after Wakeup Scene
1. Set the desired volume for Wakeup Scene 2 using the scrollbar or drop-down list.

b. Media—Click Pick Media and use the drop-down list to select Broadcast Video. Highlight a
local channel, (for example, 4-KTVX), and click OK. Set the Volume to 70.

c. Lights—De-select the box to make no changes for Wakeup Scene 2.
d. Temperature—De-select the box to make no changes for Wakeup Scene 2.
10. Click the Programming view.

Note: Your scene saves automatically, even when you leave the Agents view.

11. In the left pane, scroll down to view the available agents.
12. Select the Scheduler agent event.

The agent event appears at the top of the Script pane.
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13. In the Actions pane, scroll to the bottom to see the available agents.
14. Highlight the Wakeup agent. The available commands appear.
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15. Under the Commands tab, do the following:

a. Highlight the Wakeup scene you want to use, such as Bedroom Wakeup.

b. Highlight the location to play the scene, such as Bedroom.
16. Drag the green arrow to the Script pane.
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17. When you finish, click Execute.

5.1.15.3 Adding More Devices
To include an additional device to the Wakeup scene:

1. Inthe project tree under Device Events, if you want to include additional devices in your Wakeup
scene, scroll to the bottom of the project tree.

2. Highlight the Wakeup agent.
3. Highlight the Bedroom Wakeup.

The Wakeup event appears at the top of the Script pane.
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4. Under the Actions pane, select the device for which you want to trigger the actions when the

Wakeup event happens. Example: Select Fireplace.
5. Click the Commands tab.

6. Selectthe Turn the Bedroom ->Gas Fireplace on command. The action appears in the right

middle pane.
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7. Click and drag the green arrow to the Script pane.
8. Click Execute to execute the command.
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5.1.15.4 Bedroom Wakeup Example
At the specified time in Navigators:
Thirty minutes prior to wake-up time the temperature rises to 72 degrees.
The album of choice starts playing at 6:45 AM.
The lights start ramping up to 70 percent light level by 7:00 AM.
The fireplace turns on.
In 15 minutes, Wakeup Scene 2 begins.
The TV turns on to the local news at 7:00 AM. The Wakeup is completed.

o gk wnh e

Note: You can schedule the wakeup time from your Navigators.

6. Related Composer HE Tasks

Use the Control4® Composer HE menu bar and views to perform the following sections.
e “Using Backup As for Project Configuration and Media”
e “Connecting to a Director”
e “Exiting Composer”
e “Getting Controller Project Configuration”
e ‘“Loading the Project Configuration”
e “Searching a Topic”
e “Controlling Devices from the Interface”
o “Refreshing Navigators”
e “Viewing the Index”

6.1 Using ‘Backup As’ for Project Configuration and Media

Use the Control4® Composer HE File menu to back up your project's configuration. When you start
Composer HE and change your configuration or settings, Composer HE will ask you if you want to
back up your project. You can back it up using a different file name if you'd like.
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6.1.1 Procedure

To back up the file to a PC and save it as a different file name:
1. From the File menu, select Backup As.
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Exit

2. Type the new file name for your backup. Example: Jones Project.
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3. When prompted, click Yes if you want to back up your media information. It's always good
practice to do so.
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6.2 Connecting to a Director

Use the Control4® Composer HE menu bar to connect to a Director if you don't use the Startup screen
to connect.

6.2.1 Procedure

To connect to a Director:
1. Start Composer.
2. From the File menu, select Connect to Director.

3. From the Directors dialog, choose the Director (the network address of the Controller you are
connecting to), and then click Connect.

Address Connect

.. | 10000003

Cancel

i

Add

R efrezh

6.3 Exiting Composer

Use the Control4® Composer HE menu bar or main menu to close and exit Composer HE.

6.3.1 Procedure
To exit Composer HE two (2) ways:
1. From the Composer main menu, click Exit Composer.

2. From the File menu, select Exit. The system will ask you if you want to back up your project. It is
always good practice to do so.
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@edia Tools Help

Clear Project... Chrl+h
Load Project... Chrl40

Conreck bo Director, ..

Disconneck From Direckor

Backup Chrl4S
Backup As...
Refresh F5

Refresh Mavigators  Shift+FS

Y Exit

6.4 Getting Controller Project Configuration

Use the Control4® Composer HE startup screen or menu bar to access the latest Controller
configuration.

6.4.1 Procedure
To get the existing project configuration from a Controller:
1. Verify that your PC and the Controller are connected to the same network.
2. You can connect two (2) ways:
e From the Composer startup screen, click Director on Local Network.

CW@:

Director on
Local Network

e From the File menu, select Connect to Director.
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D Composer Home Edition
| Eile | Tools Help

Load Project.. Ctrl+0

Connect to Direckor, ..

Disconneck from Director

Backup Crrl+5
Backup &s...
Refresh FS

Refresh Mavigators  Shift+FS

Exit

When you connect to the Controller's Director, if it exists, the project configuration appears in
Composer.

6.5 Loading the Project Configuration

Use the Control4® Composer HE startup screen or menu bar to load a project.

WARNING: Loading a project will cause the current project configuration to be replaced. To avoid
losing your current project, back up your file first.

6.5.1 Prerequisite

Verify that your PC and the Controller are connected to the same network.

6.5.2 Procedure

To load the project configuration from a PC to the Controller:
1. Connect to the Director (you can do this two ways):
e From the Composer HE startup screen, click Director on Local Network.

Connect to:

Director on
Local Network

e From the File menu, select Connect to Director.
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T Composer Home Edition
Tools  Help
| Load Project... 40

Connect to Diveckor, ..
Disconmect from Director

Backup Crrl+5
Backup As. ..
Refresh FS

Refresh Mavigators  Shift+FS

Exit

2. From the File menu, select Load Project.
Click Yes when prompted to back up the project.

4. Browse to choose another project file. Example: SmithProject.c4p. When you see the new project
displayed in the System Design View, the project is loaded to the Controller, and you are

w

connected.
System Design
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6.7

6.7.1

6.7.2
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Searching a Topic

Use the Control4® Composer HE menu bar to search for a Help topic. Other topics may be available
on the Control4 web site.

Procedure

To search for Help topics:

1. From the Help menu, select Contents.

2. When the Help file opens, click the Search tab.

3. Inthe keyword box, type the topic or keywords to locate the list of related topics, and then click
List Topics.

4. In Select Topic to display, click a topic from the list of links.

Tip: You can use the Index to search for keywords by clicking the Index tab.

&2 Composer Home Edition Getting Started

H e =&

Hide Back Fomard Pint

Contents | Indes: | Seaich Home > Composer HE Getting Started > Introducing Composer Home Edition > Introducing Composer
Type i the kewword to find: Home Edition

[Topic
back forward
| oo

Selest Topis to display Composer HE Getting Started

Connesting (o a Director
Important Biasic Principles

Introducing Composer Home Edition

Cunlrul4® Composer Home Edition (HE) is a powerful software application that lets you as the
hameowner customize your Control4 system. Your Control4 Dealer has installed your Control4 system
using the professional version of Gomposer. This Composer HE application is tailored just for you.

These Getting Started topics will help you star to customize your home network with Composer HE.

What You Can Do

Controlling Devices from the Interface

Use the Control4® Composer HE main menu to configure devices.

Prerequisites

Ensure that the device is added and configured in the project. Check with your Control4 Dealer or
Installer to help you do that.

Procedure
To control a device:
1. From the project tree or Devices pane, double-click the device.

2. When the Device Control window appears, use it to control the device from the software interface
or to set parameters (such as configuring LED lights on Dimmers) temporarily.
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Note: If you make changes in the Device Control windows for a device, it only changes the device
settings temporarily. Use the Properties pane or Programming view to change the device settings
permanently.

Refreshing the Navigators

Use the Control4® Composer HE menu bar to refresh your Navigators after you've made changes to
your system. You refresh the Navigators when you change a setting in the system, attach a device,
etc.

Procedure
To refresh your Navigators:
From the File menu, select Refresh Navigators.

Tip: New media appears automatically in the Navigators unless you have a device that is
disconnected or has changed locations.
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| EH i Media  Toals
Clear Project...
Load Project, ..

Help

Conneck bo Directar...

Disconnect From Director

Baclup
Backup &s...

Y Refrash

Refresh Mavigators

Shift+F5

Exit
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Glossary

4Sight: An Internet service that provides a connection to the Home-Automation System any time and
from any place worldwide.

A
AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and
encoding scheme for digital audio. Touts better sound quality.
action: An activity that occurs when an event prompts it to do so.

agent: In Control4 programming, agents provide the ability to perform complex programming by using
functional modules. There are various types of agents; for example, Announcements, Email
Notifications, Scheduler, Lighting Scenes, Wakeup, etc.

AV: Audio Video
C

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4
products.

client: A software or hardware device that communicates to a server for feedback from the server via
an application for the user.

Command: A ‘do’ statement; actions the Director communicates to a device.
Composer: The Control4 software used to design and define a Control4 Home-Automation System.

Composer Pro: Composer is used to set up and configure Control4 devices to communicate with
each other in a Home-Automation System.

conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer
programming.

connection: Binding or linking devices together in Composer so they can communicate with each
other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor,
etc.) and can be hooked up through a security panel or directly using a Control4 Controller or
Contact/Relay Extender. Contacts connected to a Control4 Controller or Contact/Relay Extender can
be configured either as NC (normally closed) or NO (normally open).

Control4 system: A Home-Automation System designed and developed by Control4.

Controller: The main device that makes Home Automation possible. There may be multiple
Controllers within a Control4 system. The Controller that runs Director is referred to as the Primary
Controller.

D
device: A component that requires a device driver; code that is used to allow the Control4 system to
work with that device.

device driver: Every device in the Control4 system needs a corresponding device driver to control
the device.

DHCP: DHCP (Dynamic Host Configuration Protocol) - A protocol used between a network client and
a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-
defined list to clients on a network.

Digital Audio Player: Provides digital audio streaming capabilities from a Controller with hard disk
space for music and movies.

Director: Each Control4 Controller (such as a Home Controller HC-500) ships with pre-installed
Director software (Linux based) embedded in the device. The Director communicates with Control4
products and third-party products to enable Home Automation and interaction of individual devices.
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Director runs the Control4 devices. Composer Pro is the software used to connect to and program a
system Director that resides on a Controller.

DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-
AV devices.

DVD: (Digital Versatile Disc) — A media format for video and data storage.
DVR: Digital Video Recorder
E

end point: The end point is the final point (device) on the defined path over which audio and/or video
content is routed to a room. An example of this would be a TV or Receiver.

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star
network topology that allows multiple points to communicate to a single point. The Speaker Point®
and Mini Touch Screens use Ethernet to communicate to the Control4 Controller.

event: An action; used to trigger Composer programming when programming Control4 devices.
F
file format: A format used by applications to store/read files.

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in

quality.
G

gateway: (router)- Provides a means of communicating between two separate networks.
H

home network: A network installed in the customer’s home that provides an Ethernet or wireless
connection so that Control4 devices can communicate with each other.

Home-Automation System: The Control4 system: a line of Home Automation products that
communicate with each other over Ethernet, WiFi, or ZigBee for a total Home Automation experience.

Interviewer Wizard: An automated setup program in Composer that builds a project for Home
Automation.

IR: A device controlled using a wireless remote control device. Commands are sent via pulses of
infrared light to the device.

L
LCD: (Lighted Crystal Display) - A display used with some Control4 interfaces.
LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.
Linux: An operating system used by several Control4 devices.
List Navigator: A System Remote Control device uses a Navigator that lists the options.
Live Connection: A term used in Composer Pro to indicate an actual connection to the network.

Loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are
on...”

M

Media Database: Media information is stored in the Media Database, which will permit users to view
the media from the Navigators.

MP3: A music format that makes streaming audio available.
N
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Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc.
Navigator is software that the customer interacts with using a Universal Remote Control, On-Screen
Navigator, Touch Screen, or LCD Screen.

O

On-Screen Device: Allows you to select the controller (Media Controller or Home Theater Controller)
in the room that controls the source for the on-screen display.

P

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or
any combination.

Power Over Ethernet (POE): A Control4 device that is Ethernet controlled.

programming: A machine-readable artificial language used to express computations that can be
performed by a device.

project tree: A tree view in Composer where the project is layered by the larger branches (Home,
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R
ramp rate: The rate that a Dimmer ramps up its voltage.
relay: An electrical switch that opens and closes. A relay is controlled by another electrical circuit.
remote access: The ability to access a device from a remote location.

Remote Director: Connects you to the home network while working in Composer from a remote
location.

retrofit: The ability to set up a Home-Automation System in an existing structure or home. Compare
this with new building construction.

RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to devices through Ethernet
signals.

router: See gateway. Functions similar to an AP but with additional functionality for controlling the
network; for example, coordinating traffic between different networks.

S

serial-controlled device: Serial-controlled devices with an RS-232 interface and control protocol
often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled
devices are projectors, multi-disc DVD changers, etc.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients
on the local network.

system event: An action that causes another action; for example, if a projector turns on, it enables
the other devices in the system that work with the projector.

system remote: System Remote Control

System Remote Control: A Control4 System Remote Control is a universal solution that replaces
System Remote Control devices from other manufacturers, and includes programmable buttons. This
System Remote Control can access on-screen (Graphical) Navigators.

T

Touch Screen: A Touch Screen is a Home-Automation System Navigator that controls the home’s
lighting, music, videos, and other devices on the Home-Automation System.

U

Ul (user interface): The preferred term is Navigator. The Control4 interface used with Control4
devices to control Home Automation, such as Touch Screens or On-Screen Navigators.
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universal remote: Universal remote control. A third-party remote control that can be programmed to
replace other remotes in the home so that only one remote is needed, replacing all others. Control4
System Remote Control devices are a type of universal remote control.

USB: Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4
devices.

Vv

Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual Controller only (a PC is the Director host rather than the
Controller). Projects created or edited here are benign until the saved project is loaded onto a
Controller.

W

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band
using a wireless access point. This technology uses the star network topology. WiFi uses high
bandwidth 802.11.

wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between devices
connected to a network.

wireless access point: A router extension with an antenna that communicates with WiFi devices and
clients in the home. A wireless hub that connects to the wired network, and distributes the wireless
signal.

Wireless Switch: Uses the ZigBee. UL listed dimmer. Single or multi-gang. Has an air gap to cut
power.

WLAN: Wireless local area network.

WMA: (Windows Media Audio) — Audio data compression technology developed at Microsoft; an
audio file format that competes with MP3.

Z

ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer
messages from one device to another. Unlike a star network topology where devices can only send
messages to each other by sending them first to a single central device (which then delivers the
message to the recipient device), a mesh network topology allows the devices to forward messages
from one device to another, thereby extending the effective range of the network. Uses low bandwidth
802.15.4. 250 devices are allowed per controller but Control4 recommends 125.

ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing
more interoperability with other Control4 devices, support for home automation profiles, and improves
the scalability of multiple ZigBee access points.
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8. Index

AAC files, 11

Action, 30

Actions pane, 48

Actions, described, 31

Add commands and conditionals, 44
Add DVDs, CDs, 14

Add new variable, 50

Add/Remove Load, Lighting Scenes, 72
Agent examples, 58

Agent types, 56

Agent, Custom Agent Variable Boolean, 41
Agents, 6

Agents view, 56

Agents, in programming, 32

Agents, programming, 56

Album tab, 26
AM radio, 21
AMG, 13

AMG lookup, media, 11
Announcement Agent, 56, 58
Announcement example, 58
Announcement, add text message, 61
Audio output, 93

Audio Video, Room Properties, 9
Auto scan, 22

Backup As, 101

Backup system configuration, 101
Basic programming, 31

Blue question mark, 45

Blue question mark, programming, 37
Boolean, 92

Boolean values, 47

Break command, in programming, 35
Cast and Synopsis tab, 29

CD, add, 14

Change localization options, 9
Change Password, 10

Change project date, time, 9
Change project name, 9

Change Project Properties, 10
Change project settings, 9
Change zip code, 9

Character set selection, 10
Commands tab, 34

Composer HE Getting Started, 6
Composer HE, main view, 8
Conditional loop, programming, 40
Conditionals tab, 44

Conditionals, in programming, 36
Connect to Director, 104

Contact Information, 2

Container Variables, 57, 92
Control4 System Quick Start Guide, 6
Control4 System User Guide, 6
Copyright, 2

Cover Art, not found, 13

Create an action, 48

Create conditional, 48

Create event, 48

Custom Agent Variable Agent String, 49
Custom buttons, 56

Custom Buttons, 81

Custom Buttons Agent, 56, 64
Custom Buttons, in Navigators, 64
Custom Variable, 92

Custom Variables, 57

Date, 10

Delay command, in programming, 35
Delete media, 14

Device Actions, 87

Device Control window, 107
Device controls, 7

Device Events pane, 48

Device Properties, 9

Device status, check, 9

Devices, add to Wakeup Scene, 99
Digital Audio, 12

Digital Audio Player, and Controller, 12
Digital Audio sources, 12

Dimmer options, and Lighting Scenes, 72
Director on Local Network, 104
Director, connect, 103

Disc Changer, 12

Disc Changer, and media setup, 13
Disc Changer, auto scan, 22

Disc Changer, scan media, 14
Disclaimer, 2

DVD, add, 14

DVR, 93

Edit CD information, 26

Edit DVD information, 29

Edit media, 14

Edit media information, 26

E-Mail Notification Agent, 56, 67
Event, 30

Events, described, 31

Example, Actions pane, 92
Example, Events pane, 91
Example, Lighting Scene, 73
Example, program commands, 33
Example, using conditionals, 36
Examples, agents, 58
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Examples, events and actions, 30 Network file storage, 12
Execute Off Scene, and Lighting Scenes, 72 Network share, 11
Execute On Scene, and Lighting Scenes, 72 Network-attached storage, 23

Exit Composer, 103

External storage device, use, 23
File extension, add, 18

FLAC files, 11

FM radio, 21

Global Access Custom Buttons, 80
GNU, 2

Gracenote, 2, 13

Gracenote lookup, media, 11
Green arrow, 45

Green arrow, and programming, 34
iTunes, 11

Keypad_presses, variable, 47
Latitude, 10

Legal Notice, 2

Lighting Scenes Agent, 57, 69
List view, 7

Load Project, 106

Local Broadcast Listings, 19
Locale, 10

Longitude, 10

Macro Agent, 57

Macros Agent, 74

Media, 6

Media Auto-Scan, 17

Media Controller, 11

Media Controller, and media lookup, 13
Media database, 11

Media Database, 13

Media Managers, 11

Media Monkey, 11

Media Player, auto scan, 22
Media Player, scan files, 17
Media Player, set up videos, 17
Media scanning, status messages, 18
Media scene, 42

Media Scenes Agent, 57, 76
Media view, 11, 12

Media, remove, 18

Media, scan, 11

Monitor system status, 7
Monitoring, 6

Monitoring view, 7

Movie tab, 29

MP3, 11

MPEG, 2

Multiple video displays, 93
Multiple video sources, 93
Navigator, Room Properties, 9
Navigators, and media selection, 11
Navigators, refresh, 108

New Event dialog, 85
New variable agent, Boolean, 41
New variable agent, number, 47
Online help, 107
0S 20,6
Password, 9
Playlist, create, 24
Playlist, example set up, 50
Programming commands, 33
Programming in HE, 30
Programming view, 6, 33
Project name, 10
Project properties, 9
Project tree, 12
Project, backup, 101
Properties pane, 7, 8
Push Setting Control, 10
Push Settings From Project, 10
Radio stations, set up, 21
Refresh Navigators, 108
Related Documents, 6
Remove media, 18
Rhapsody Agent, 79
Rhapsody playlist, 24
Room object, 38
Room Properties, 9
Room Variable, 92
Room Variables, 57
Room variables, descriptions, 40
Room variables, in programming, 38
Room variables, using, 38
Save As, project, 102
Scan Digital Audio media, 12
Scan media, 11, 14
Scan Now, 19
Scanning

iTunes, 18

Schedule, 18

USB drive, 18

Windows Media Player, 18
Scheduler Agent, 57, 84
Scheduler agent, example, 32
Scheduler pane, 85
Screen Saver Agent, 57, 87
Script pane, 33
Script pane, example, 37
Script pane, programming, 30
Script, defined, 31
Search media titles, 14
Search media, Disc Changer, 14
Security, 10
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Set up media, 12

Set up media auto scan, 22

Sony 777 Disc Changer, 11

Sony Disc Changer, auto-scan, 17
Speaker Point, 12

SSL, 9, 10

Start timer, 88

Stop command, in programming, 35
Stop Scan, 19

Stop timer, 88

Switch options, and Lighting Scenes, 72
Sync All Scenes, Lighting Scenes, 72
Synch This Scene, and Lighting Scenes, 72
System security, 10

Television, set up channels, 19

Test media control, 22

Text/image, edit, 61

Time, 10

Timer Agent, 57, 88

Timer behavior, Timer Agent, 90
Timezone, 10
TV, set up channels, 19
UHF/VHF, 19
USB drive

scan, 18
USB drive, playing media, 23
Variable, add new, 50
Variable, agent Boolean, 41
Variables agent, 50
Variables Agent, 57, 92
Video switching, 93
Video Wall Agent, 57, 93
Volume, add to announcement, 62
Wakeup Agent, 57, 94
WAV file, add to announcement, 61
Windows Media Player, 11

Windows Start menu, add media files, 13

XM radio, 21
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